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1 Product description 

The ResistancePlus® MG kit simultaneously detects M. genitalium and 5 mutations at positions 2058 and 2059 in the 23S rRNA gene 
(E. coli numbering) that are associated with resistance to azithromycin (macrolide-based antibiotic). The ResistancePlus® MG kit is 
a 1-well real-time PCR multiplex consisting of 3 readouts. Readout 1 indicates the presence or absence of M. genitalium through 
detection of the MgPa gene; Readout 2 indicates the presence of a A2058G, A2059G, A2058T, A2058C or A2059C mutation in the 
23S rRNA gene; and Readout 3 is an internal control to monitor extraction efficiency and qPCR inhibition. The ResistancePlus® MG 
kit utilises PlexZyme® and PlexPrime® for specificity and superior multiplexing capability. The assay is validated on samples extracted 
using the MagNA Pure 96 System (Roche), MICROLAB STARlet IVD (Hamilton), QIAsymphony® SP (QIAGEN), NUCLISENS® 
easyMAG® (Biomérieux) and real-time detection on the Roche LightCycler® 480 Instrument II (LC480 II), cobas z 480 analyser (z480), 
the Applied Biosystems® 7500 Fast (7500 Fast), Applied Biosystems® 7500 Fast Dx (7500 Fast Dx) and the Bio-Rad CFX96™ Dx 
(CFX96 Dx) and CFX96 Touch™ (CFX96 Touch) Real-time PCR Detection Systems. 

2 Intended use 

The ResistancePlus® MG kit is a qualitative multiplexed in vitro diagnostic real-time PCR test for the identification of M. genitalium 
and detection of 5 mutations in the 23S rRNA gene (A2058G, A2059G, A2058T, A2058C, and A2059C, Escherichia coli numbering) 
that are associated with resistance to azithromycin (macrolide antibiotic). It is intended to aid in the diagnosis of M. genitalium and 
detects mutations associated with azithromycin resistance in M. genitalium and should be used in conjunction with clinical and other 
laboratory information. 

The ResistancePlus® MG kit may be used with the following specimen types: male and female urine, and anal, rectal, cervical, 
endocervical, vaginal, urethral, penile, penile meatal and pharyngeal swabs, from symptomatic and asymptomatic patients.  

Negative results do not preclude M. genitalium infections and do not provide confirmation of azithromycin susceptibility as there may 
be other mechanisms of treatment failure. 

The ResistancePlus® MG kit is intended to be used in professional settings such as hospitals, or reference or state laboratories. It is 
not intended for self-testing, home use, or point of care use. 

3 Pathogen information 

M. genitalium is small bacterium that is found in the human urogenital tract. M. genitalium has been associated with a range of sexually 
transmitted infections (STIs). In men, it is the second most common cause of non-gonococcal urethritis (NGU), and is also associated 
with prostatitis, epididymitis, and balanoposthitis, inflammation of the glans penis and prepuce1. In women, it is associated with 
cervicitis, pelvic inflammatory disease (PID), including endometritis (inflammation of the endometrial lining) and salpingitis 
(inflammation of the fallopian tubes)1,2,3. 

Azithromycin is commonly used for the treatment of M. genitalium and for the syndromic management of STIs such as NGU and 
cervicitis. Azithromycin belongs to the macrolide class of antibiotics and acts by binding to the 23S rRNA to inhibit protein synthesis. 
Point mutations in the 23S rRNA gene of M. genitalium, A2058G, A2059G, A2058T, A2058C and A2059C (E. coli numbering) have 
been associated with treatment failure and/or in vitro resistance to azithromycin4,5. The most common mutations are A2058G and 
A2059G, contributing 89% of macrolide resistance mutations in a recent study6. 

4 Kit contents 

 

Table 1. Contents for ResistancePlus® MG kits 

Cap colour Contents Description 
Cat no 20001L-01 

(100 reactions) 

Cat no 2000125 

(25 reactions) 

Blue Plex Mastermix, 2x 
Mastermix containing components necessary 
for qPCR including dNTPs, MgCl2, DNA 
polymerase and buffer 

1 x 1 ml 1 x 250 μl 

Brown MG+23S Mix, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of M. genitalium 
and 23S rRNA mutations 

1 x 100 μl 1 x 25 μl 

White Control Mix 1, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of internal control 
assay for LC480 II and z 480 

1 x 100 μl 1 x 25 μl 

Red Internal Control Cells# 
Internal control cells containing internal control 
DNA template to monitor extraction and 
amplification efficiency 

1 x 500 μl 1 x 100 μl 

Neutral Nuclease Free Water PCR grade water 1 x 1 ml 1 x 1 ml 

# Store template tubes separately from oligo mixes, i.e. template or nucleic acid handling room 

^ Oligonucleotides are PCR primer pairs (including PlexPrime® primers), PlexZyme® enzymes and fluorescent probe 
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Table 2. Contents for ResistancePlus® MG(550) kits 

Cap colour Contents Description 
Cat no 2000201 

(100 reactions) 

Cat no 2000225 

(25 reactions) 

Blue Plex Mastermix, 2x 
Mastermix containing components necessary 
for qPCR including dNTPs, MgCl2, DNA 
polymerase and buffer 

1 x 1 ml 1 x 250 μl 

Brown MG+23S Mix, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of M. genitalium 
and 23S rRNA mutations 

1 x 100 μl 1 x 25 μl 

White Control Mix 2, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of internal control 
assay for 7500 Fast and 7500 Fast Dx 

1 x 100 μl 1 x 25 μl 

Red Internal Control Cells# 
Internal control cells containing internal control 
DNA template to monitor extraction and 
amplification efficiency 

1 x 500 μl 1 x 100 μl 

Neutral Nuclease Free Water PCR grade water 1 x 1 ml 1 x 1 ml 

# Store template tubes separately from oligo mixes, i.e. template or nucleic acid handling room 

^ Oligonucleotides are PCR primer pairs (including PlexPrime® primers), PlexZyme® enzymes and fluorescent probe 
 

Table 3. Contents for ResistancePlus® MG(675) kits 

Cap colour Contents Description 
Cat no 2000301 

(100 reactions) 

Cat no 2000325 

(25 reactions) 

Blue Plex Mastermix, 2x 
Mastermix containing components necessary 
for qPCR including dNTPs, MgCl2, DNA 
polymerase and buffer 

1 x 1 ml 1 x 250 μl 

Brown MG+23S Mix, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of M. genitalium 
and 23S rRNA mutations 

1 x 100 μl 1 x 25 μl 

White Control Mix 3, 20x 
Mix containing oligonucleotides^ for 
amplification and detection of internal control 
assay for CFX96 Dx and CFX96 Touch 

1 x 100 μl 1 x 25 μl 

Red Internal Control Cells# 
Internal control cells containing internal control 
DNA template to monitor extraction and 
amplification efficiency 

1 x 500 μl 1 x 100 μl 

Neutral Nuclease Free Water PCR grade water 1 x 1 ml 1 x 1 ml 

# Store template tubes separately from oligo mixes, i.e. template or nucleic acid handling room 

^ Oligonucleotides are PCR primer pairs (including PlexPrime® primers), PlexZyme® enzymes and fluorescent probe 

 

5 Shipping and storage 

- The components of the ResistancePlus® MG kits are shipped on dry ice or ice gel packs. All components should be stored at 
-25°C to -15°C upon receipt. It is recommended that freeze/thaw cycles are limited to 15.  

- When stored under the recommended conditions and handled correctly, activity of the kit is retained until the expiry date stated 
on the label. Do not use past expiry date. 

- Any serious incident shall be reported to SpeeDx by contacting tech@speedx.com.au 

 

6 Warnings and precautions 

6.1 General 

- For in vitro diagnostic use only. 

- Carefully read these Instructions for Use prior to use. Closely follow procedures as described to ensure reliability of test results. 
Any deviation from these procedures may affect test performance. 

mailto:tech@speedx.com.au
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- Users should be adequately trained in the use of the ResistancePlus® MG assay. 

- Any serious incident shall be reported to the manufacturer and competent authority of the Member State in which user and/or 
patient is established. 

 

6.2 Laboratory 

- It is recommended to perform sample preparation/extraction, mastermix preparation, sample addition and thermocycling in 
spatially separated spaces. At a minimum the PCR instrument should ideally be in a separate room to areas where reactions are 
prepared. 

- It is recommended to follow routine laboratory precautions. Wear appropriate personal protective equipment such as gloves, 
protective eye wear and laboratory coat when handling reagents. 

- Pathogenic organisms may be present in clinical specimens. Treat all biological specimens as potentially infectious and follow 
your institution’s safety procedures for handling chemicals and biological samples. 

- Follow your institution’s hazardous waste disposal procedures for proper disposal of specimens, reagents and other potentially 
contaminated materials.  

 

6.3 Specimen handling 

- Specimens should be collected, transported and stored using standard laboratory techniques or according to collection kit 
instructions. 

 

6.4 Assay 

- Basic precautions for preventing contamination of PCR reactions include the use of sterile filter pipette tips, use of a new pipette 
tip for every pipetting action, and separation of workflow. 

- PCR tests are prone to contamination from previous PCR products. Never open reaction vessels after the completion of PCR. 

- Assay reagents contain IDTE Buffer which can cause severe eye irritation. It is recommended to use in a well-ventilated area and 
wear appropriate personal protective equipment such as gloves, protective eye wear and laboratory coat when handling reagents.  

 

6.5 Safety precautions 

- Safety Data Sheets (SDS) are available on request. Please contact tech@speedx.com.au for more information. 

 

6.6 Assay Plugins: Warnings/Precautions/Limitations 

- SpeeDx software can only control the analysis of raw data generated from the test kit when used with its respective PCR 
instrument. It does not control the preparation of samples, reactions, programming of equipment or delivery of treatment. 

- Users should be adequately trained in the use of the ResistancePlus® MG analysis software and the access should be limited to 
each assigned single user 

- It is recommended to implement user authentication access and cybersecurity controls such as anti-virus software or use of a 
firewall within the IT system and infrastructure which uses the software 

- Upon detection of a cybersecurity incident such as unauthorised access and ransomware attacks, please contact 
tech@speedx.com.au for further support. 

 

7 Associated Products and Consumables 

Positive Control Material 

- ResistancePlus® MG Positive Control kit (SpeeDx, Cat no 95001) 

 

General lab consumables 

- Gloves and clean lab coats 

- Vortex mixer 

- Benchtop centrifuge for 0.5 ml and 1.5 ml tubes  

mailto:tech@speedx.com.au
mailto:tech@speedx.com.au
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- Micropipettors 

- Sterile aerosol-resistant pipette tips 

- 0.5 ml tubes and 1.5 ml tubes (PCR-grade) 

- 2.0 ml tubes (for pre-dilution of internal control cells) 

 

For MagNA Pure 96 Instrument 

- 1x Phosphate Buffered Saline (PBS) 

- MagNA Pure 96 Internal Control Tube (Roche, Cat no 06374905001) 

- MagNA Pure 96 DNA and Viral NA Small Volume Kit (Roche, Cat no 06543588001) 

- MagNA Pure 96 DNA and Viral NA Large Volume Kit (Roche, Cat no 06374891001) 

- MagNA Pure 96 System Fluid (external) (Roche, Cat no 06640729001) 

- MagNA Pure 96 Processing Cartridge (Roche, Cat no 06241603001) 

- MagNA Pure 96 Pure tip 1000uL (Roche, Cat no 6241620001) 

- MagNA Pure 96 Output Plate (Roche, Cat no 06241611001) 

- MagNA Pure Sealing Foil (Roche, Cat no 06241638001) 

 

For MICROLAB STARlet Instrument 

- 1x Phosphate Buffered Saline (PBS) 

- STARMag 96 X 4 Universal Cartridge kit (384T) kit (Seegene, Cat No 744300.4.UC384) 

- 2.0 ml tubes  

 

For QIAsymphony® SP instrument  

- 1x Phosphate Buffered Saline (PBS)  

- Sample Prep Cartridges, 8-well (Qiagen, Cat no 997002)  

- 8-Rod Covers (Qiagen, Cat no 997004)  

- Filter tips, 200 μl and 1500 μl (Qiagen, Cat no 990332 and 997024)  

- 2 ml tubes (Sarstedt, Cat no 72.639 or 72.694)  

- 14 ml polystyrene tubes (Corning, Cat no 352051)  

- DSP Virus/Pathogen Mini Kit (QIAGEN, Cat no 937036) 

 

For NucliSENS® easyMAG® instrument 

- 1x Phosphate Buffered Saline (PBS) 

- NucliSENS® easyMAG® Lysis Buffer 4X1L (Biomerieux, Cat no 280134) 

- NucliSENS® easyMAG® Lysis Buffer 2ML 48T (Biomerieux, Cat no 200292) 

- NucliSENS® easyMAG® Magnetic Silica (Biomerieux, Cat no 280133) 

- NucliSENS® easyMAG® Extraction buffer 1 (Biomerieux, Cat no 280130) 

- NucliSENS® easyMAG® Extraction buffer 2 (Biomerieux, Cat no 280131) 

- NucliSENS® easyMAG® Extraction buffer 3 (Biomerieux, Cat no 280132) 

- NucliSENS® easyMAG® Disposables (Biomerieux, Cat no 280135) 

 

For LightCycler® 480 Instrument II and cobas z 480 analyser 

- PlexPCR® Colour Compensation (CC) kit (SpeeDx, Cat no 90001) 
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- LightCycler® 480 Multiwell Plate 96 (Roche, Cat no 04729692001) 

- LightCycler® 480 Sealing Foil (Roche, Cat no 04729757001) 

 

For Applied Biosystems® 7500 Fast and 7500 Fast Dx 

- MicroAmp® Optical 96-well reaction plates (ThermoFisher Scientific, Cat no 4316813) 

- MicroAmp® Optical Adhesive Film (ThermoFisher Scientific, Cat no 4360954) 

 

For Bio-Rad CFX96™ Dx and CFX96 Touch™ Real-time PCR Detection System 

- Multiplate™ 96-well PCR plates (Bio-Rad, Cat no MLP9601) 

- Microseal® ‘B’ PCR Plate Sealing Film, adhesive, optical (Bio-Rad, Cat no MSB1001) 

 

Sample Collection Devices 

- Multi-Collect Specimen Collection Kit (Abbott, Cat no 9K12-01) 

- Aptima® Urine Collection Kit (Hologic, Cat no 301040) 

- Aptima® unisex swab specimen collection kit (Hologic, Cat no 301041) 

- DeltaSwab ViCUM® 2 ml + Standard flocked swab (deltalab, Cat no 304278) 

- Vacumed® Urine without preservative (FL medical, Cat no 44950) 

- Regular FLOQSwab™ in 1 ml of UTM™ media (Copan Cat no 359C) 

- cobas® PCR media (Roche, Cat no 06466281190) 
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8 Principle of the technology 

Real-time PCR (qPCR) can be used to amplify and detect specific target nucleic acids from pathogens. PlexPCR® is a qPCR 
technology utilising PlexZyme® enzymes that detect and report the amplified product through the generation of a fluorescent signal 
(Figure 1). PlexPrime® primers for specific amplification of mutant sequences which is coupled with mutant specific PlexZyme® 
detection (Figure 2). 

PlexZyme® enzymes are catalytic DNA complexes composed of two DNA oligos referred to as “Partial Enzymes”. Each Partial Enzyme 
has a target-specific region, a catalytic core and a universal probe binding region. When the target product is present, the two Partial 
Enzymes bind adjacently to form the active PlexZyme® which has catalytic activity to cleave a labelled probe. Cleavage separates the 
fluorophore and quencher dyes, producing a fluorescent signal that can be monitored in real time. PlexZyme® enzymes have additional 
specificity compared to alternate detection technologies, since two Partial Enzymes are required to bind for detection. PlexZyme® 
enzymes are also multiple turnover enzymes, and multiple probes can be cleaved during each PCR cycle, resulting in a strong and 
sensitive signal. PlexZyme® assays are highly sensitive and specific and are ideally suited for the multiplexed detection of pathogens. 

PlexPrime® primers have three functional regions. The long 5’ region anchors the primer to a particular location, and the short 3’ 
region selectively targets extension from the mutant base. An Insert sequence lies between the 5’ and 3’ regions and acts as a bridging 
structure which inserts a target-independent sequence into the resulting amplicon and increases the selective pressure of the 3’ region. 
In multiplex, each PlexPrime® primer is designed to target a specific mutant base and will incorporate a unique Insert sequence, thus 
producing distinct mutant amplicon sequences. Unlike other probe-based detection technologies, the PlexZyme® enzyme can be 
overlapped with the PlexPrime® primer to target the specific mutant amplicon containing the mutant base and incorporated Insert 
sequence. The unique combination of PlexPrime® primers coupled to PlexZyme® enzymes allows the specific amplification of mutant 
sequences, and sensitive and specific detection in multiplex. 

 

Figure 1. Schematic representation of PlexZyme® detection and universal signalling 
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Figure 2. Schematic representation of the PlexPrime® primer coupled with PlexZyme® detection. The PlexPrime® primer 
specifically amplifies mutant sequence and PlexZyme® enzymes specifically detect the amplicon. 
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9 Procedure overview 
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10 Detailed procedure 

Note: Provided reagents are named in italics and colour of the tube cap follows in brackets. 

 

10.1 Sample collection, transport and storage 

Male urine, female urine, urethral, anal, rectal, pharyngeal, penile, penile meatal, cervical, endocervical and vaginal swabs, from 
symptomatic or asymptomatic patients should be collected, transported, and stored using standard laboratory techniques or according 
to collection kit instructions. 

 

10.1.1 Validated sample collection devices 

Inadequate or inappropriate specimen collection, storage and transport are likely to yield false test results. Proper training in specimen 
collection is highly recommended to ensure specimen quality and stability.   

Sample collection devices that have been validated with the ResistancePlus® MG kit are included below with short guidance regarding 
the device manufacturer’s instructions for collection, handling and transport. These instructions are not intended to replace or 
supersede any instructions provided by the manufacturer. Always refer to specimen collection device manufacturer instructions for 
proper collection methods.  

Prior to any collection method, trained staff must ensure proper understanding of the device and methodology. At minimum review 
the test description for the following:  indication of specimen type, sufficient volume, procedure(s), necessary collection materials, 
patient preparation, and proper handling and storage instructions. 

 

10.1.2 Neat urine collection, transport and storage 

1. Use of a clear sterile urine collection cup, free of any preservatives or transport media is recommended for patient self-
collection.  

2. Patient should collect 20-50ml of first void urine and tightly recap or screw on lid.  
3. It is recommended to double bag urine specimen with absorbent pads for transport. Storage temperatures of urine specimen 

is dependent on the intended processing time.  

 

10.1.3 Dry swab collection, transport and storage 

Dry swabs may be used for various clinician and patient collection specimens. Due to the variability, refer to the manufacturers 
package insert for appropriate specimen types and collection methods. 

 

10.1.4 Multi-Collect Specimen Collection Kit (Abbott, Cat no 9K12-01) collection, transport and storage 

Directions are summarized below for the collection and transport of urine, vaginal swabs and male urethral swabs with the multi-
Collect Specimen Collection Kit (Abbott, Cat no 9K12-01) 

 

10.1.4.1 Urine specimen collection, transport and storage 

1. The patient should not have urinated for at least one hour prior to sample collection. 
2. Discard specimen collection swab; it is not required for urine specimen collection. 
3. Using a urine specimen collection cup, the patient should collect the first 20 to 30 mL of voided urine (the first part of the 

stream). 
4. Unscrew the transport tube cap, taking care not to spill the transport buffer within. 
5. Handle the cap and tube carefully to avoid contamination. 
6. Use the plastic transfer pipette to transfer urine from the collection cup into the transport tube until the liquid level in the tube 

falls within the clear fill window of the transport tube label or else a new specimen should be collected. Do not overfill. 
Slightly more than one full squeeze of the transfer pipette bulb may be required to transfer the necessary volume of urine 
specimen. 

7. Recap the transport tube carefully. Ensure the cap seals tightly. 
8. Label the transport tube with sample identification information, including date of collection using an adhesive label. Take 

care not to obscure the fill window on the transport tube. 
9. After collection, transport and store transport tube at 2°C to 30°C for up to 14 days. If longer storage is needed, store at  

-10°C or colder for up to 90 days. 

 

10.1.4.2 Vaginal swab specimen collection, transport and storage 

1. Discard disposable transfer pipette; it is not required for vaginal swab specimen collection. 
2. Remove the sterile swab from the wrapper, taking care not to touch swab tip or lay it down on any surface. 
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3. Insert the white tip of the specimen collection swab about two inches (5 cm) into the opening of the vagina. 
4. Gently rotate the swab for 15 to 30 seconds against the sides of the vagina. 
5. Withdraw the swab carefully. 
6. Handle the cap and tube carefully to avoid contamination. 
7. Unscrew the transport tube cap and immediately place the specimen collection swab into the transport tube so that the 

white tip is down. 
8. Carefully break the swab at the scored line on the shaft; use care to avoid splashing of contents. 
9. Recap the transport tube. Ensure the cap seals tightly. 
10. Label the transport tube with sample identification information, including date of collection using an adhesive label. 
11. After collection, transport and store transport tube at 2°C to 30°C for up to 14 days. If longer storage is needed, store at  

-10°C or colder for up to 90 days. 

 

10.1.4.3 Male urethral swab specimen collection, transport and storage 

1. The patient should not have urinated for at least one hour prior to sample collection. 
2. Discard disposable transfer pipette; it is not required for male urethral swab specimen collection. 
3. Remove the sterile swab from the wrapper, taking care not to touch swab tip or lay it down on any surface. 
4. Insert the white tip of the specimen collection swab 3/4 to 1 1/2 inches 
5. (2 to 4 cm) into the urethra. 
6. Gently rotate the swab for 2 to 3 seconds to ensure adequate sampling. 
7. Withdraw the swab carefully. 
8. Handle the cap and tube carefully to avoid contamination. 
9. Unscrew the transport tube cap and immediately place the specimen collection swab into the transport tube so that the 

white tip is down. 
10. Carefully break the swab at the scored line on the shaft; use care to avoid splashing of contents. 
11. Recap the transport tube. Ensure the cap seals tightly. 
12. Label the transport tube with sample identification information, including date of collection using an adhesive label. 
13. After collection, transport and store transport tube at 2°C to 30°C for up to 14 days. If longer storage is needed, store at  

-10°C or colder for up to 90 days. 

 

10.1.5 Aptima® Urine Collection Kit (Hologic, Cat no 301040) collection, transport and storage 

Directions are summarized below for the collection and transport of male and female urine specimen with the Aptima® Urine Collection 
Kit. 

1. Use of a clear sterile urine collection cup, free of any preservatives or transport media is recommended for patient self-
collection.  

2. Patient is directed to provide 20-30 mL of first void urine into provided urine collection cup. Female patients should not 
cleanse the labial area prior to providing the specimen. 

3. Using the pipette and transport tube included in Aptima® Urine Collection Kit, transfer 2mL of urine with the pipette into the 
uncapped specimen transport tube. Proper urine volume line must fall within the black fill lines on the urine transport tube. 
Urine must be transferred from the clear sterile urine cup to the Aptima urine specimen tube within 24 hours of collection. 

4. Re-cap the urine transport tube tightly. 
5. After collection, processed urine specimens in the Aptima urine specimen transport tube should be transported and stored 

at 2°C to 30°C and store at 2°C to 30°C until tested. Refer to manufacturer’s instructions for detailed storage optimization.  

 

10.1.6 Aptima® unisex swab specimen collection kit (Hologic, Cat no 301041) collection, transport and storage 

Directions are summarized below for the collection and transport of endocervical swab specimen and male urethral swab with the 
Aptima® unisex swab specimen collection kit (Hologic, Cat no 301041). 

 

10.1.6.1 Endocervical swab specimen collection, transport and storage 

1. Remove excess mucus from the cervical os and surrounding mucosa using the cleaning swab (white shaft swab in the 
package with red printing). Discard this swab. Note: To remove excess mucus from the cervical os, a large-tipped swab (not 
provided) may be used. 

2. Insert the specimen collection swab (blue shaft swab in the package with the green printing) into the endocervical canal. 
3. Gently rotate the swab clockwise for 10 to 30 seconds in the endocervical canal to ensure adequate sampling. 
4. Withdraw the swab carefully; avoid any contact with the vaginal mucosa. 
5. Remove the cap from the swab specimen transport tube and immediately place the specimen collection swab into the 

transport tube. 
6. Carefully break the swab shaft against the side of the tube at the score line and discard the top portion of the swab shaft; 

use care to avoid splashing of contents. 
7. Re-cap the swab specimen transport tube tightly. After collection, transport and store the swab in the swab specimen 

transport tube at 2°C to 30°C until tested. 
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10.1.6.2 Male urethral swab specimen collection, transport and storage 

1. The patient should not have urinated for at least 1 hour prior to sample collection 
2. Insert the specimen collection swab (blue shaft in package with green printing) 2 to 4 cm into the urethra 
3. Gently rotate the swab clockwise for 2 to 3 seconds in the urethra to ensure adequate sampling 
4. Withdraw the swab carefully 
5. Remove the cap from the swab specimen transport tube and immediately place the specimen collection swab into the 

transport tube 
6. Carefully break the swab shaft against the side of the tune at the scoreline and discard the top portion of the swab shaft; 

use care to avoid splashing of contents 
7. Re-cap the swab specimen transport tube tightly. After collection, transport and store the swab in the swab specimen 

transport tube at 2°C to 30°C until tested. 

 

10.1.7 DeltaSwab ViCUM® 2 ml + Standard flocked swab (deltalab, Cat no 304278) collection, transport and storage 

Directions are summarized below for the collection and transport of vaginal, cervical, urethral, pharyngeal and rectal swab specimens 
with the DeltaSwab ViCUM® 2 ml + Standard flocked swab (deltalab, Cat no 304278).  

1. Open peel-pack using both hands pulling opposite sides. 
2. Agitate the tube smoothly. 
3. Open the flow-pack and collect the sample with the swab. 
4. Open the tube with the other hand and place the swab inside so that it is covered with the media. 
5. Align the breakpoint of the swab with the top of the tube lightly pressing the swab downwards. Break the swab by the 

breakpoint by supporting it on the 
6. inner edge of the tube. 
7. Discard leftover piece of stick, screw cap tightly and shake the sample to elute it into the media. 
8. After collection, transport and store the swab in the swab specimen transport tube at 4°C to 25°C until tested. 

 

10.1.8 Vacumed® Urine without preservative (FL medical, Cat no 44950) collection, transport and storage 

Directions are summarized below for the collection and transport of male and female urine with the Vacumed® Urine without 
preservative collection tube (FL medical, Cat no 44950).  

1. Open the cap of the urine collection container and lay upside down on a clean surface 
2. Do not touch internal surfaces of the container and cap 
3. Collect the urine sample. Fill the container up to ¾ of the capacity 
4. Replace the cap and turn tightly in a clockwise direction to seal 
5. Gently shake the sample 
6. Partially raise the protective label (do not remove it completely) 
7. Insert the sample tube and apply gentle pressure. Keep the tube connected until it is full (end of flow) 
8. Remove the sample tube and fully restick the protective label 
9. Store the sample tube at 4°C to 25°C until tested 

 

10.1.9 Regular FLOQSwab™ in 1 ml of UTM™ media (Copan Cat no 359C) collection, transport and storage 

Directions are summarized below for the collection and transport of female vaginal swab specimens with the Regular FLOQSwab™ 
in 1 ml of UTM™ media (Copan Cat no 359C) 

1. Open the UTM kit package and remove the medium test tube and the internal bag containing the sterile swab. 
2. Take the sterile swab out of its bag and collect the clinical specimen; to prevent the risk of contamination, make sure that 

the swab tip comes into contact with the collection site only. 
3. After collecting the specimen, unscrew and remove the cap from the test tube taking care not to spill the medium. 
4. Insert the swab into the test tube until the breakpoint is level with the test tube opening. 
5. Bend and break the swab at the breakpoint holding the test tube away from your face and discard the excess part. 
6. Screw the cap back onto the test tube and hermetically seal it. 
7. Process the specimen contained in the UTM within 48 hours from collection storing the test tube at 2-25°C. 
8. Before processing, vortex for 20 seconds in order to encourage specimen release from the swab and homogenize the 

medium. 

 

10.1.10 cobas® PCR media (Roche, Cat no 06466281190) collection, transport and storage 

Directions are summarized below for the collection and transport of male and female urine within cobas® PCR media (Roche, Cat no 
06466281190). 

1. Mix and transfer the urine into the cobas® PCR Media tube using a disposable pipette (not provided). Note: urine can be 
stored at 2°C to 30°C for up to 24 hours prior to transferring into the cobas® PCR Media tube 

2. The correct volume of urine has been added when the fluid level is between the two black lines on the tube label 
3. Tightly re-cap the cobas® PCR Media tube 
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4. Invert the tube 5 times to mix. The specimen is now ready for transport and testing 
5. Transport and store the cobas® PCR Media tube containing the stabilized urine specimen at 2ºC to 30ºC. 

 

10.1.11 Validated sample extracts 

Sample extracts validated for use include: 

- cobas® x480 (from CT/NG protocol) 

 

See Section 10.5 for instructions to prepare PCR with Extracted Nucleic-Acids (reflex workflow). 

 

10.2 Sample processing 

The ResistancePlus® MG kit has been validated on the following extraction instruments in Table 4.  

 

See Section 10.3 for instructions to use the Internal Control. 

Table 4. Validated extraction protocols 

Instrument Extraction kit Sample volume Protocol Elution volume 

MagNA Pure 96a 
MagNA Pure 96 DNA and Viral 
NA Small Volume Kit 

200 μl Pathogen Universal 200 50 μl or 100 μl 

MagNA Pure 96a 
MagNA Pure 96 DNA and Viral 
NA Large Volume Kit  

1000 μl^ Viral NA Universal LV 1000 3.1 100 μl 

MICROLAB 
STARlet IVDb 

STARMag 96 x 4 Universal 
Cartridge kit (Seegene) 

300 μl 

10 μl diluted Internal Control Cells 

added per sample  

Select ‘Pause before PCR setup’ to 
perform sample extraction only 

100 μl 

QIAsymphony SPc DSP Virus/Pathogen Mini Kit  200 μl  Complex200_V6_DSP  110 μl  

NucliSENS® 
easyMAG®d 

NucliSENS® easyMAG® 
reagents 

200 μl swab Generic 2.01; “On-board” workflow 100 μl 

1000 μl urine Generic 2.01; “Off-board” workflow 100 μl 

a See 10.3.1 for how to use the internal control with the MagNA Pure 96  

b See 10.3.2 for how to use the internal control with the STARlet IVD 

c See 10.3.3 for how to use the internal control with the QIAsymphony SP 

d See 10.3.4 for how to use the internal control with the NucliSENS® easyMAG® 

^ Increase sample volume input for specimens collected in media (e.g. Aptima Collection kits) 

 

10.3 Internal Control (IC)  

The kit includes an internal control to monitor extraction efficiency and qPCR inhibition. The internal control assay is provided as a 
Control Mix (WHITE) and Internal Control Cells (RED). The Control Mix is added to the PCR Master Mix (Table 11). The Internal 
Control Cells contain the internal control DNA template. The Internal Control Cells are diluted and processed as below for specific 
extraction instruments. The internal control DNA template is therefore co-extracted with the sample and co-amplified in the reaction. 

 

10.3.1 Internal Control on the MagNA Pure 96 

Dilute the Internal Control Cells (RED) 1 in 200 in 1x PBS (Table 5). Adjust volume as required using the same dilution factor (see 
extraction kit manual for minimum volume for required number of samples). The diluted internal control cells are loaded into the 
Internal Control Tube on the MagNA Pure 96: 

- For the MagNA Pure 96 DNA and Viral NA Small Volume Kit (Pathogen Universal 200 protocol), 20 μl is automatically added to 
each sample (default). 

- For the MagNA Pure 96 DNA and Viral NA Large Volume Kit (Viral NA Universal LV 1000 3.1 protocol), the sample volume is 
divided and processed in two separate wells of the MagNA Pure 96 Processing Cartridge. A total of 40 µl of diluted internal control 
cells are automatically added to each sample (20 µl per well of the processing cartridge).  

Note: Do NOT store diluted Internal Control Cells 
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Table 5. Dilution of Internal Control Cells for the MagNA Pure 96 (1 in 200 dilution) 

Internal Control Cells 
(RED) (μl) 

1x PBS (μl) Total volume (μl) Volume added to sample 
(μl) 

18 3582 3600 20 

 

10.3.2 Internal Control on the MICROLAB STARlet IVD 

Dilute the Internal Control Cells (RED) 1 in 20 in 1x PBS (Table 6). Adjust volume as required using the same dilution factor (see 
extraction kit manual for minimum volume for required number of samples). The diluted internal control cells are loaded into a 2 ml 
tube and placed on the reagent support rack, with 10 μl automatically added to each sample.  

Note: Do NOT store diluted Internal Control Cells 

 

Table 6. Dilution of Internal Control Cells for the MICROLAB STARlet IVD (1 in 20 dilution) 

Internal Control Cells 
(RED) (μl) 

1x PBS (μl) Total volume (μl) Volume added to sample 
(μl) 

50 950 1000 10 

 

10.3.3 Internal Control on the QIAsymphony® SP 

Dilute the Internal Control Cells (RED) 1 in 50 in 1x PBS (Table 7). Adjust volume as required using the same dilution factor according 
to the number of samples required.  

Note: Do NOT store diluted Internal Control Cells 

 

Table 7. Dilution of Internal Control Cells for the QIAsymphony® SP (1 in 50 dilution) 

Internal Control Cells (RED) (μl) 1x PBS (μl) Total volume (μl) 

40 1950 2000 

 

The diluted Internal Control Cells are then used to prepare an Internal Control-carrier RNA-Buffer AVE mixture, as shown in Table 8 
below. Adjust volume as required using the same dilution factor for the number of samples required (see extraction kit manual for 
minimum volume for required number of samples). The Internal Control-carrier RNA-buffer AVE mixture should be prepared 
immediately before starting the run.  

The Internal Control-carrier RNA-buffer AVE mixture is added to a tube, which is placed into a tube carrier and loaded into slot A of 
the sample drawer in the QIAsymphony® SP. 120 μl (default) of the mixture is added to each sample. 

 

Table 8. Preparation of Internal Control-carrier RNA-buffer AVE mixture for the QIAsymphony SP 

Tube type Number of samples 
Volume of diluted 

IC Cells (μl) 
Stock carrier 

RNA (μl) 
Buffer AVE 

(μl) 
Total volume (μl) 

- 1 10 3 107 120 

2 ml 1 + void volume^ 40 12 428 480 

14 ml 1 + void volume# 60 18 642 720 

^ 2 ml tube requires 3 additional samples (360 μl) to account for void volume 

# 14 ml tube requires 5 additional samples (600 μl) to account for void volume 
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10.3.4 Internal Control on the easyMAG® 

Dilute the Internal Control Cells (RED) 1 in 200 in 1x PBS (Table 9). Adjust volume as required using the same dilution factor. Prepare 
a ‘pre-mix’ of diluted internal control cells and NucliSENS® easyMAG® Magnetic Silica for the required number of samples (Table 10). 
100 μl of pre-mix silica is required per sample. 

 

Note: Do NOT store diluted Internal Control Cells 

 

Table 9. Dilution of Internal Control Cells for the NucliSENS® easyMAG® (1 in 200 dilution) 

Internal Control Cells 
(RED) (μl) 

1x PBS (μl) Total volume (μl) Dilution factor 

10 1990 2000 200 

 

Table 10. Pre-mix of NucliSENS® easyMAG® Magnetic Silica and diluted Internal Control Cells 

Number of samples 
Volume of diluted IC Cells 

(μl) 
Volume of Magnetic Silica 

(μl) 
Volume added to sample 

(μl) 

1 50 50 100 

 

“On-board” or “off-board” workflow will be used depending on the specimen type. “Off-board” workflow is used for optimal nucleic acid 
recovery of urine samples. Refer to the NucliSENS® easyMAG® user manual for more information. 

 

 “On-board” workflow (swabs) 

Transfer specimens into the sample vessel. 

Load sample vessels onto the easyMAG. 

Program the following Extraction Requests: 

Protocol: Generic 2.0.1 (for software version 2.0) 

Matrix: Other 

Volume (ml): 0.200 

Eluate (μl): 100 μl 

Type: Primary 

After on-board lysis, add 100 μl of pre-mix silica to each sample. 

Continue extraction process. 

 

“Off-board” workflow (urine) 

Briefly spin down NucliSENS Lysis Buffer tube and add 1000 μl urine. Vortex tube. 

Let mixture stand at room temperature for 10 mins. 

After lysis, transfer lysates to the sample vessels and load onto the easyMAG. 

Add 100 μl of pre-mix silica to each sample. 

Program the following Extraction Requests: 

Protocol: Generic 2.0.1 (for software version 2.0) 

Matrix: Other 

Volume (ml): 1.000 

Eluate (μl): 100 μl 

Type: Lysed 

Continue extraction process. 
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10.4 Preparation of real-time PCR 

Note: Before use of reagents, thaw completely, and mix thoroughly by briefly vortexing 

 

Refer to Table 1 - Table 3 for description of kit contents. 

 

10.4.1 Master Mix preparation 

Make up the Master Mix as outlined in Table 11.  

For a 20 μl reaction volume, 15 μl Master Mix and 5 μl sample is required. Pipette the Master Mix into the PCR plate and then add 
extracted sample to the reaction.  

A no template control (NTC) should be included with each run. For the NTC reaction, add Nuclease Free Water (NEUTRAL) instead 
of sample.  

Seal plate, centrifuge and transfer to thermocycler. 

 

Table 11. Master Mix 

Reagent Concentration Volume per 20 μl reaction (μl) 

Nuclease Free Water (NEUTRAL) N/A 3.0 

Plex Mastermix (BLUE) 2x 10.0 

MG+23S Mix (BROWN) 20x 1.0 

Control Mix҂ (WHITE) 20x 1.0 

Total volume (μl) 15.0 

Add 5 μl sample for a final volume of 20 μl 

҂ The Control Mix included in each kit is specific to the PCR instrument used; refer to Table 1 - Table 3  for 
correct Control Mix to use 

 

10.4.2 Master Mix stability  

The Master Mix can be prepared in bulk and stored at -20°C for up to 4 weeks or stored at 4°C for up to 1 week. 

 

10.5 Preparation of PCR with Extracted Nucleic-Acids (reflex workflow) 

Nucleic-acid extracts obtained without the addition of Internal Control Cells (RED) to samples can be tested using the ResistancePlus® 
MG kit. 

This procedure should only be followed for extracts that: 

Have been tested previously on an alternate assay platform following the manufacturer’s instructions for use, and where the previously 
performed test generated a valid result. 

Mastermix should be prepared as per Section 10.4.1. In the context of reflex testing, the Internal Control is not present in the sample 
extract. However, the control mix must be included as described in Section 10.4.1. 

Refer to Table 1 - Table 3 for description of kit contents. 

Make up the reaction mix as outlined in Table 11. For a 20 μl reaction volume, 15 μl Master Mix and 5 μl sample is required. Pipette 
the Master Mix into the PCR plate and then add extracted sample to the reaction. 

A no template control (NTC) should be included with each run. For the NTC reaction, add Nuclease Free Water (NEUTRAL) instead 
of sample. Seal plate, centrifuge, and transfer to thermocycler. 

 

11 Programming and analysis 

Details for programming and analysis are described in the Section 19 - Section 23. 
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The ResistancePlus® MG kit has three channels for detection of M. genitalium, 23S rRNA mutation and Internal Control (Table 12).  

The ResistancePlus® MG software is restricted to the analysis of results corresponding to nucleic-acid extracts obtained with the 
addition of Internal Control Cells (RED) to samples. 

For Nucleic-acid extracts obtained without the addition of Internal Control Cells (RED) to samples, the REFLEX ResistancePlus® MG 
software should be used. The REFLEX ResistancePlus® MG software has two channels for detection of M. genitalium and 23S rRNA 
mutation (Table 13). 

This procedure should only be followed for extracts that: 

Have been tested previously on an alternate assay platform following the manufacturer’s instructions for use, and where the previously 
performed test generated a valid result. 

 

Table 12. Channels for ResistancePlus® MG targets 

Instrument Channel A Channel B Channel C 

 M. genitalium detection 
(MgPa) 

23S rRNA mutation Internal Control 

LC480 II 465-510 533-580 533-640 

z 480 465-510 540-580 540-645 

7500 Fast and 7500 Fast Dx FAM JOE TAMRA 

CFX96 Dx and CFX Touch FAM HEX Quasar 705 

 

Table 13. Channels for ResistancePlus® MG targets for reflex workflow 

Instrument Channel A Channel B 

 M. genitalium detection (MgPa) 23S rRNA mutation 

LC480 II 465-510 533-580 

z 480 465-510 540-580 

7500 Fast and 7500 Fast Dx FAM JOE 

CFX96 Dx and CFX Touch FAM HEX 

 

12 Interpretation of results 

Data interpretation requires the ResistancePlus® MG analysis software. While PlexPrime® primers offer greater specificity than other 
allele-specific primers, some non-specific amplification from the 23S rRNA mutant assay may be seen in samples that contain high 
concentrations of M. genitalium wild type 23S rRNA. The ResistancePlus® MG analysis software automates the data interpretation of 
amplification results and streamlines workflow. Instructions for how to use the analysis software are described in Section 24.  

See Table 14 for the appropriate analysis software for each real-time PCR instrument. The analysis software can be supplied on 
request. Please contact tech@speedx.com.au for more information. 

 

Table 14. ResistancePlus® MG analysis software 

Cat no Analysis software* Real-time PCR instrument 

99003 ResistancePlus® MG (LC480) LC480 II 

99018 ResistancePlus® MG (z 480) z 480 

99002 ResistancePlus® MG (7500) 7500 Fast and 7500 Fast Dx 

99008 ResistancePlus® MG (CFX) CFX96 Dx and CFX96 Touch 

mailto:tech@speedx.com.au
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99023 REFLEX ResistancePlus® MG (LC480)  LC480 II 

99024 REFLEX ResistancePlus® MG (z480) z 480 

99026 REFLEX ResistancePlus® MG (7500) 7500 Fast and 7500 Fast Dx 

99025 REFLEX ResistancePlus® MG (CFX) CFX96 Dx and CFX96 Touch 

* Refer to the website https://plexpcr.com/products/sexually-transmitted-infections/resistanceplus-mg/#resources to 
ensure you are using the most current version of analysis software 

 

13 Limitations 

- The ResistancePlus® MG assay targets the MgPa gene for M. genitalium and mutations at positions 2058 and 2059 in the 23S 
rRNA gene (A2058G, A2059G, A2058T, A2058C, A2059C, E. coli numbering) that are associated with resistance to azithromycin 
(macrolide-based antibiotic). 

- The ResistancePlus® MG assay should only be performed by personnel trained in the procedure and should be performed in 
accordance to these Instructions for Use. 

- Reliable results are dependent on adequate specimen collection transport, storage, and processing. Failure to observe proper 
procedures in any one of these steps can lead to incorrect results. 

- The ResistancePlus® MG assay is a qualitative assay and does not provide quantitative values or information about organism 
load. 

- Results from the test must be correlated with the clinical history, epidemiological data, laboratory data and any other data available 
to the clinician. 

- Prevalence of M. genitalium and macrolide resistance will affect the positive and negative predictive values for the assay. 

- Detection of antibiotic resistance markers may not correlate with phenotypic gene expression. 

- Therapeutic failure or success cannot be determined based on the assay results,since nucleic acid may persist following 
appropriate antimicrobial therapy. 

- Negative results do not exclude the possibility of infection due to improper specimen collection, technical error, presence of 
inhibitors, specimen mix up, or low numbers of organisms in the clinical specimen.  

- Negative results for the resistance markers do not indicate susceptibility of detected microorganisms, as resistance markers not 
measured by the assay or other potential mechanisms of antibiotic resistance may be present. 

- False positive results may occur due to cross-contamination by target organisms, their nucleic acids or amplified product. 

  

https://plexpcr.com/products/sexually-transmitted-infections/resistanceplus-mg/#resources
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14 Quality control 

The ResistancePlus® MG kit includes an internal control to monitor extraction efficiency and qPCR inhibition (Section 10.3).  

When performing reflex testing, the ResistancePlus® MG kit internal control cells have not been added in the extraction process. 
Reflex testing can only be performed on samples previously found valid with another system, ensuring extraction efficiency and qPCR 
inhibition had been monitored. 

The ResistancePlus® MG Positive Control kit (Cat no 95001) is recommended as positive control material for nucleic acid 
amplification. Refer to Section 15 for instructions to use the ResistancePlus® MG Positive Controls. A known negative specimen is 
recommended to be used as a negative control. 

 

15 ResistancePlus® MG Positive Control instructions 

The ResistancePlus® MG Positive Control kit contains positive control material for M. genitalium 23S rRNA mutants and a M. 
genitalium wild type 23S rRNA (Table 15). 

 

Table 15. Contents for ResistancePlus® MG Positive Control kit (Cat no 95001) 

Cap colour Contents Description 
Quantity  

(10 reactions) 

Neutral MG, 23S rRNA wild type 
Positive control template for the detection of M. genitalium, 
23S rRNA wild type 

1 x 50 μl 

Green MG, 23S rRNA A2058G 
Positive control template for the detection of M. genitalium, 
23S rRNA A2058G mutation 

1 x 50 μl 

Red MG, 23S rRNA A2059G 
Positive control template for the detection of M. genitalium, 
23S rRNA A2059G mutation 

1 x 50 μl 

Blue MG, 23S rRNA A2058T 
Positive control template for the detection of M. genitalium, 
23S rRNA A2058T mutation 

1 x 50 μl 

Yellow MG, 23S rRNA A2058C 
Positive control template for the detection of M. genitalium, 
23S rRNA A2058C mutation 

1 x 50 μl 

Purple MG, 23S rRNA A2059C 
Positive control template for the detection of M. genitalium, 
23S rRNA A2059C mutation 

1 x 50 μl 

 

15.1 Instructions for use 

Prepare qPCR reactions as described in Section 10.4 using positive control as sample. 

Data interpretation requires the ResistancePlus® MG analysis software, refer to Section 24.11 for example results.  
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16 Performance characteristics 

16.1 Clinical performance 

16.1.1 Clinical Study 1 

A prospective-retrospective clinical study was conducted at Royal Women’s Hospital (RWH), Melbourne, Australia. Samples were 
collected from May 2016-June 2016 and based on the clinical laboratory results, 111 M. genitalium positive and 100 consecutive M. 
genitalium negative samples were selected for inclusion in the study. The 211 samples consisted of 84 urine, 7 anal swabs, 1 
urogenital swab (no site specified (nss)), 1 rectal swab, and 1 urethral swab from men, and 33 urine, 33 cervical swabs, 16 
endocervical swabs, 14 vaginal swabs, 13 high vaginal swabs, and 8 urogenital swabs (nss) from women. To determine performance 
of the ResistancePlus® MG kit, M. genitalium detection was compared to the clinical laboratory results from a well-established 16S 
rRNA qPCR used for routine diagnostics at RWH7, and 23S rRNA mutant detection was compared to Sanger sequencing8. The 
ResistancePlus® MG kit was performed on the LC480 II, after sample extraction on the MagNA Pure 96 Instrument using the MagNA 
Pure 96 DNA and Viral NA Small Volume Kit using the Universal Pathogen 200 protocol. For M. genitalium detection, a composite 
reference was used for discordant samples using a third qPCR reaction targeting the MgPa gene9. For 23S rRNA mutant detection, 
Sanger sequencing was taken as the true result. Resolved results and sensitivity and specificity of the ResistancePlus® MG kit for M. 
genitalium detection and 23S rRNA mutant detection are shown in Table 16. Two specimens were excluded as the Internal Control 
result was invalid (1 female urine and 1 male urine). Analysis of 23S rRNA mutation detection only includes samples where the mutant 
status could be determined. Analysis of results in accordance to specimen type is shown in Table 17. The 23S rRNA mutation analysis 
is shown in Table 18. 

 

Table 16. Clinical evaluation of the ResistancePlus® MG kit (Clinical Study 1) 

 M. genitalium detection 

16S rRNA qPCR 

  23S rRNA mutant detection 

Sequencing 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG 

Positive 106 0  Mutant detected 68 2 

Negative 4 99^  Mutant not detected 2 31 

 

Sensitivity 96.4% (95% CI 91.0-99.0%)  Sensitivity 97.1% (95% CI 90.1-99.7%) 

Specificity 100.0% (95% CI 96.3-100.0%)  Specificity 93.8% (95% CI 79.2-99.2%) 

95% CI – 95% confidence interval; Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. 
coli numbering); Wild type – absence of mutation in these positions 

^ The ResistancePlus® MG kit detected 1 true M. genitalium negative using composite reference, table represents resolved results 
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Table 17. Clinical result analysis in accordance to specimen^ (Clinical Study 1) 

Specimen Expected M. genitalium 
negative 

Expected M. genitalium 
23S rRNA wild type 

Expected M. genitalium 
23S rRNA mutant 

Male urine 28/28 8/101 41/421 

Female urine 12/13 11/11 4/62 

Cervical swab 21/21 5/5 7/73 

Endocervical swab 10/10 3/3 3/34 

Vaginal swab 8/8 1/1 2/25 

High vaginal swab 9/9 1/1 4/46 

Male anal swab 3/3 0/0 5/57 

Female swab (nss) 5/5 2/2 1/18 

Male swab (nss) 0/0 0/0 1/19 

Male rectal swab 1/1 0/0 0/0 

Male urethral swab 1/1 0/0 0/0 

Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. coli numbering); Wild type – 
absence of mutation in these positions 

^ 2 female urine, 3 male urine, 1 vaginal swab excluded as sequencing failed and mutant status could not be determined 

1 Male urine: 2 M. genitalium wildtype miscalled as M. genitalium mutant detected, 18 A2058G, 20 A2059G, 3 A2058T correctly 
detected; 1 A2058G miscalled as M. genitalium not detected 

2 Female urine: 1 A2058G, 3 A2059G correctly detected; 2 A2059G miscalled as M. genitalium detected, mutant not detected 

3 Cervical swab: 1 A2058G, 6 A2059G correctly detected 

4 Endocervical swab: 2 A2059G, 1 A2058T correctly detected 

5 Vaginal swab: 3 A2058G, 1 A2059G correctly detected 

6 High vaginal swab: 2 A2059G correctly detected 

7 Male anal swab: 1 A2058G, 3 A2059G, 1 A2058T correctly detected.  

8 Female swab (no site specified (nss)): 1 A2059G correctly detected 

9 Male swab (nss): 1 A2059G correctly detected 

 

Table 18. M. genitalium 23S rRNA mutation analysis 
(Clinical Study 1) 

Reference result^ ResistancePlus® MG result 

Wild type 31/331 

A2058G 24/252 

A2059G 39/413 

A2058T 5/5 

^ For M. genitalium positive samples only 

1 Wild type: 2 Male urine miscalled as M. genitalium mutant detected 

2 A2058G: 1 Male urine miscalled as M. genitalium not detected 

3 A2059G: 2 Female urine miscalled as M. genitalium mutant not detected 
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16.1.2 Clinical Study 2 

A subset of the extracted specimens from study 1 were run on the 7500 Fast. Results were compared to the clinical result from the 
16S rRNA qPCR (Twin 2011) and Sanger sequencing (Twin 2012). Discordant samples for M. genitalium detection were re-tested 
with the 16S rRNA qPCR (Twin 2011) due to suspected sample degradation. Resolved results and sensitivity and specificity of the 
ResistancePlus® MG(550) kit for M. genitalium detection and 23S rRNA mutant detection are shown in Table 19. Analysis of 23S rRNA 
mutation detection only includes samples where the mutant status could be determined.  

 

Table 19. Clinical evaluation of the ResistancePlus® MG(550) kit (Clinical Study 2) 

 M. genitalium detection 

16S rRNA qPCR 

  23S rRNA mutant detection 

Sequencing 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG 

Positive 99 0^  Mutant detected 62 0 

Negative 2 81#  Mutant not detected 5 30 

 

Sensitivity 98.0% (95% CI 93.0-99.8%)  Sensitivity 92.5% (95% CI 83.4-97.5%) 

Specificity 100.0% (95% CI 95.6-100.0%)  Specificity 100.0% (95% CI 88.4-100.0%) 

95% CI – 95% confidence interval; Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. 

coli numbering); Wild type – absence of mutation in these positions 

^ The ResistancePlus® MG(550) kit detected 1 true M. genitalium positive using reference test, table represents resolved results 

#  The ResistancePlus® MG(550) kit detected 10 samples true M. genitalium negatives using reference test, table represents resolved 
results 

 

16.1.3 Clinical Study 3 

A retrospective clinical study was conducted at Canterbury Health Laboratories (CHL), Christchurch, New Zealand on characterised, 
archived samples from 2010-2016, consisting of 103 M. genitalium positive and 61 M. genitalium negative samples, collected with the 
multi-Collect Specimen Collection Kit (Abbott). The 164 samples consisted of 110 urine and 4 rectal swabs from men, and 11 urine, 
17 cervical swabs, 15 vaginal swabs, 1 urethral swab, 1 urethral/vaginal swab, 1 vaginal/cervical swab and 4 samples from unknown 
sites from women. To determine performance of the ResistancePlus® MG kit, M. genitalium detection was compared to the clinical 
laboratory result from a well-established MgPa qPCR, which is also used for routine diagnostics at CHL (Jensen 2004), and 23S rRNA 
mutant detection was compared to Sanger sequencing (Jensen 2008). The ResistancePlus® MG kit was performed on the LC480 II, 
after sample extraction on the MagNA Pure 96 Instrument using the MagNA Pure 96 DNA and Viral NA Small Volume Kit using the 
Universal Pathogen 200 protocol. For M. genitalium detection, the routine MgPa test was repeated for discordant samples. For 23S 
rRNA mutant detection, Sanger sequencing was taken as the true result. The sensitivity and specificity of the ResistancePlus® MG 
kit for M. genitalium detection and 23S rRNA mutant detection are shown in Table 20. Five samples were excluded as the Internal 
Control result was invalid. Analysis of 23S rRNA mutation detection only includes samples where the mutant status could be 
determined. Analysis of results in accordance to specimen type is shown in Table 21. The 23S rRNA mutation analysis is shown in 
Table 22.  

 

Table 20. Clinical evaluation of the ResistancePlus® MG kit (Clinical Study 3) 

 M. genitalium detection 

16S rRNA qPCR 

  23S rRNA mutant detection 

Sequencing 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG 

Positive 90 0  Mutant detected 61 1 

Negative 7 67^  Mutant not detected 6 22 

 

Sensitivity 92.8% (95% CI 85.7-97.1%)  Sensitivity 91.0% (95% CI 81.5-96.6%) 

Specificity 100.0% (95% CI 94.6-100.0%)  Specificity 95.6% (95% CI 79.7-99.9%) 

95% CI – 95% confidence interval; Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. 

coli numbering); Wild type – absence of mutation in these positions 

^ The ResistancePlus® MG kit detected 7 true M. genitalium negatives, table represents resolved results 
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Table 21. Clinical result analysis in accordance to specimen (Clinical Study 3) 

Specimen Expected M. genitalium 
negative 

Expected M. genitalium 
wild type 

Expected M. genitalium 
23S rRNA mutant 

Male urine 45/45 17/181 38/471 

Female urine 4/4 1/1 6/62 

Cervical swab 5/5 3/3 8/93 

Vaginal swab 6/6 1/1 8/84 

Male rectal swab 3/3 0/0 0/15 

Female (unknown site) 1/1 1/1 1/26 

Female urethral swab 1/1 0/0 0/0 

Urethral/vaginal swab 1/1 0/0 0/0 

Vaginal/cervical swab 1/1 0/0 0/0 

Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. coli numbering); Wild type – absence 
of mutation in these positions 

1 Male urine: 1 M. genitalium wild type miscalled as M. genitalium mutant detected, 4 A2058G, 32 A2059G, 1 A2058T, 1 A2058C, 1 A2059C, 
correctly detected; 1 A2058G, 1 A2059G and 1 A2059C miscalled as M. genitalium not detected, 3 A2058G and 2 A2059G miscalled as M. 
genitalium mutant not detected 

2 Female urine: 2 A2058G, 4 A2059G correctly detected 

3 Cervical swab: 3 A2058G, 4 A2059G, 1 A2058C correctly detected; 1 A2059G miscalled as M. genitalium not detected 

4 Vaginal swab: 1 A2058G, 7 A2059G correctly detected 

5 Male rectal swab: 1 A2059G miscalled as M. genitalium not detected 

6 Female (unknown site): 1 A2059G correctly detected; 1 A2059G miscalled as M. genitalium mutant not detected 

 

Table 22. M. genitalium 23S rRNA mutation analysis 
(Clinical Study 3) 

Reference result^ ResistancePlus® MG result 

Wild type 22/231 

A2058G 10/132 

A2059G 47/503 

A2058T 1/1 

A2058C 2/2 

A2059C 1/1 

^ For M. genitalium positive samples only 

1 Wild type: 1 Male urine miscalled as M. genitalium mutant detected 

2 A2058G: 3 Male urine miscalled as M. genitalium mutant not detected 

3 A2059G: 2 Male urine miscalled as M. genitalium mutant not detected, 
1 Female sample (unknown site) miscalled as M. genitalium mutant not 
detected 

  



Instructions for Use (IFU)    

IF-IV0003 v13.0 (July 2023)  Page 27 of 77 

EN 

16.1.4 Clinical Study 4  

A retrospective clinical study was performed at Vall d’Hebron University Hospital (HUVH), Barcelona, Spain, to evaluate the 
performance of the ResistancePlus® MG(675) kit for the detection of M. genitalium and azithromycin resistance-associated mutations 
in retrospective samples collected between December 2017-April 2018. Samples included 92 M. genitalium positive and 108 
consecutive M. genitalium negative specimens, collected using the DeltaSwab ViCUM® (Deltalab, Spain) for swabs or Vacumed® 
Urine (FL medical, Italy) for male and female urine. The 200 samples consisted of 46 urine, 30 vaginal swabs, 30 urethral swabs, 40 
cervical swabs, 8 pharyngeal swabs and 46 rectal swabs. Samples were extracted with the STARlet IVD (Hamilton) and run on the 
CFX96 Dx (Bio-Rad) instrument. To assess the performance, M. genitalium detection was compared to Allplex™ STI Essential 
(Seegene) as well as to the ResistancePlus® MG kit (SpeeDx) on the LC480 II for both M. genitalium detection and 23S rRNA status. 
The sensitivity and specificity of the ResistancePlus® MG(675) kit for M. genitalium detection compared to Allplex™ STI Essential 
(Seegene) is shown in Table 23. The sensitivity and specificity of the ResistancePlus® MG(675) kit for M. genitalium detection was 
100.0% (95% CI 95.9-100.0%) and 97.4% (95% CI 92.4-99.5%), respectively and for 23S rRNA mutant detection was as shown in 
Table 24. Analysis of results in accordance to specimen type is shown in Table 25. 

 

Table 23. Comparison of ResistancePlus® MG(675) kit with 
Allplex™ STI essential (Clinical Study 4) 

 
M. genitalium detection 

Allplex™ STI Essential  

 
Positive Negative 

ResistancePlus® 
MG(675) 

Positive 89 1 

Negative 3 107 

 

Sensitivity 96.7% (95% CI 90.8-99.3%) 

Specificity 99.1% (95% CI 94.95-100.0%) 

 

Table 24. Clinical evaluation of the ResistancePlus® MG(675) kit (Clinical Study 4) 

 M. genitalium detection 

 ResistancePlus® MG 
(LC480 II) 

  23S rRNA mutant detection# 

ResistancePlus® MG 
(LC480 II) 

 Positive Negative   Mutant 
detected 

Mutant not 
detected 

ResistancePlus® 
MG(675) 

Positive 87 3  Mutant detected 42^ 0 

Negative 0 110  Mutant not detected 2 42* 

 

Sensitivity 100.0% (95% CI 95.9-100.0%)  Sensitivity 95.5% (95% CI 84.5-99.4%) 

Specificity 97.4% (95% CI 92.4-99.5%)  Specificity 100.0% (95% CI 91.6-100.0%) 

95% CI – 95% confidence interval; Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, and A2059C positions (E. 

coli numbering); Wild type – absence of mutation in these positions 

^ The ResistancePlus® MG(675) kit detected 1 true M. genitalium mutant using reference test, table represents resolved results 

* The ResistancePlus® MG(675) kit detected 1 true M. genitalium negative using reference test, table represents resolved results 

# 1 sample excluded from analysis as this was sequenced as mixed wild-type and mutant 
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Table 25. Clinical result analysis in accordance to specimen (Clinical Study 4) 

Specimen Expected M. genitalium 
negative 

Expected M. genitalium 
23S rRNA wild type 

Expected M. genitalium 
23S rRNA mutant 

Male urine 26/26 5/5 15/15 

Male urethral swab 15/15 3/3 11/121 

Female cervical swab 16/16 11/11 2/33 

Female vaginal swab 20/20 15/15 5/5 

Male rectal swab 19/221 5/5 8/8 

Female rectal swab 7/7 3/3 0/0 

Male pharyngeal swab 5/5 0/0 1/1 

Female pharyngeal swab 2/2 0/0 0/0 

1 Male rectal swab: 3 M. genitalium negative miscalled as M. genitalium positive 

2 Male urethral swab: 1 M. genitalium 23S rRNA mutation positive miscalled as M. genitalium 23S rRNA mutation negative 

3 Female cervical swab: 1 M. genitalium 23S rRNA mutation positive miscalled as M. genitalium 23S rRNA mutation negative 

 

16.1.5 Clinical Study 5  

A retrospective clinical study was conducted at Royal Women’s Hospital (RWH), Melbourne, Australia using Aptima® collected urine 
and swabs from June 2017-November 2017. Matched patient specimens consisted of 98 M. genitalium positive and 87 consecutive 
M. genitalium negative, collected as neat urine (routine sample) or with the Aptima® Urine Specimen Collection kit (Hologic), or as dry 
swab (routine sample) or with the Aptima® Unisex Swab Specimen Collection kit (Hologic). The 185 samples consisted of 122 urine, 
18 rectal swabs, 15 cervical swabs, and 25 vaginal swabs. To determine the performance of Aptima® collected samples with the 
ResistancePlus® MG kit, M. genitalium and 23S rRNA mutant detection was compared to the clinical diagnostic results obtained from 
the ResistancePlus® MG kit (SpeeDx) using the routine sample. Testing of Aptima® collected samples was performed on the LC480 
II, after sample extraction on the MagNA Pure 96 Instrument using the MagNA Pure 96 DNA and Viral NA Small Volume Kit using the 
Viral NA Universal LV 1000 protocol. Clinical diagnostic results from RWH, obtained from a matched diagnostic sample tested with 
the ResistancePlus® MG kit (SpeeDx), was taken as the true result for M. genitalium. For the 23S rRNA mutant detection, the result 
was compared to the diagnostic result and Sanger sequencing.  

The sensitivity and specificity of the ResistancePlus® MG kit for M. genitalium detection and 23S rRNA mutant detection are shown 
in Table 26. Analysis of 23S rRNA mutation detection only includes samples where the mutant status could be determined. Analysis 
of results in accordance to specimen type is shown in Table 27.  

 

Table 26. Clinical evaluation of the ResistancePlus® MG kit (Clinical Study 5) 

 M. genitalium detection 

ResistancePlus® MG 
(routine sample) 

  23S rRNA mutant detection 

ResistancePlus® MG 
(routine sample) 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG (with 1ml 
Aptima sample) 

Positive 94 3  Mutant detected 65 0 

Negative 4 84  Mutant not detected 1* 28 

 

Sensitivity 95.9% (95% CI 89.9-98.9%)  Sensitivity 98.5% (95% CI 91.8-100.0%) 

Specificity 96.6% (95% CI 90.3-99.3%)  Specificity 100.0% (95% CI 87.7-100.0%) 

* Sample could not be sequenced 
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Table 27. Clinical result analysis in accordance to specimen type (Clinical Study 5) 

Specimen 
Expected M. genitalium 

negative 
Expected M. genitalium wild 

type 
Expected M. genitalium 23S 

rRNA mutant 

Urine 50/521 21/221 45/481 

Cervical swab 11/11 1/1 3/3 

Vaginal swab 14/152 3/42 6/6 

Rectal swab 9/9 3/3 5/63 

Anal swab 0/0 0/0 5/5 

Mutant – 23S rRNA mutation in A2058G, A2059G, A2058T, A2058C, A2059C positions (E.coli numbering); Wild type – 
absence of mutation in these positions 

1 Urine: 2 M. genitalium negatives miscalled as M. genitalium wild type and mutant respectively; 1 M. genitalium wild type 
miscalled as M. genitalium negative; 2 M. genitalium mutants miscalled as M. genitalium wild type, 1 M. genitalium mutant 
miscalled as M. genitalium negative 

2 Vaginal swab: 1 M. genitalium negative miscalled as M. genitalium wild type; 1 M. genitalium wild type miscalled as M. 

genitalium negative  

3 Rectal swab: 1 M. genitalium mutant miscalled as M. genitalium negative 

 

16.1.6 Clinical Study 6 

A retrospective clinical study was conducted at University of Queensland Centre for Clinical Research (UQCCR), Australia, using 
cobas® x480 extracts from urine and swab samples collected from February 2017-February 2019. Specimens consisted of 85 M. 
genitalium positive and 84 M. genitalium negative extracts, originally collected as neat urine or with the cobas® PCR media collection 
kit (Roche) and extracted on the cobas® x480 (cobas® 4800, Roche) instrument using the “Full Workflow” and “CT/NG” protocol, 
without addition of SpeeDx Internal Control Cells. The 169 extracts consisted of 28 rectal swabs, 13 vaginal swabs, 5 high vaginal 
swabs, 15 cervical swabs, 1 ectocervical swab, 5 urethral swabs, 5 pharyngeal swabs, 1 penile swab, 1 penile meatal, 1 mouth swab, 
as well as 83 male and 11 female urine specimens.  

To determine the performance of cobas® extracts with the ResistancePlus® MG(550) kit, M. genitalium detection was compared to the 
routine diagnostic result (MgPa PCR assay (Trembizki et al., 2017)) and 23S rRNA mutant detection was compared to Sanger 
sequencing. The ResistancePlus®

 MG(550) kit was performed on the ABI 7500 Fast Dx. The sensitivity and specificity of the 
ResistancePlus® MG(550) kit for M. genitalium detection and 23S rRNA mutant detection are shown in Table 28. Analysis of 23S rRNA 
mutation detection only includes samples where the mutant status could be determined. Analysis of results in accordance to specimen 
type is shown in Table 29. The 23S rRNA mutation analysis is shown in Table 30. 

 

Table 28. Clinical evaluation of the ResistancePlus® MG(550) kit (Clinical Study 6) 

 M. genitalium detection 

MgPa qPCR 
 

  23S rRNA mutant detection 

Sanger Sequencing 
 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG(550) 

Positive 80 0  Mutant detected 49^ 0 

Negative 5 84  Mutant not detected 0 25 

 

Sensitivity 94.1% (95% CI 86.8-98.1%)  Sensitivity 100.0% (95% CI 92.8-100.0%) 

Specificity 100.0% (95% CI 95.7-100.0%)  Specificity 100.0% (95% CI 86.3-100.0%) 

^ 1 vaginal sample returned a mixed wild-type/A2059G sequencing result which was correctly identified as mutant by the 

ResistancePlus® MG(550) assay 
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Table 29. Clinical result analysis in accordance to specimen (Clinical Study 6) # 

Specimen Expected M. genitalium 
negative 

Expected M. genitalium 
23S rRNA wild type 

Expected M. genitalium 
23S rRNA mutant 

Male urine 42/42 13/13 26/271 

Female urine 6/6 1/1 3/32  

Cervical swab  5/5 6/6 2/23 

Ectocervical swab 1/1 - - 

Vaginal swab 1/1 1/2  7/74^ 

High vaginal swab 2/2 2/2 1/15 

Male rectal swab 17/17 1/1 7/86 

Female rectal swab 1/1 - - 

Male urethral swab 3/3 - 2/27 

Male pharyngeal 5/5 - - 

Penile swab - 1/1 - 

Penile meatal swab - - 1/18 

Male mouth swab 1/1 - - 

# 6 samples were excluded as sequencing failed and true 23S status could not be determined, including: 2 cervical, 2 urine, 1 
vaginal and 1 rectal sample 

1 Male urine: 8 A2058G, 3 A2058T and 15 A2059G correctly identified; 1 A2058T was incorrectly identified as M. genitalium 
not detected 

2 Female urine: 2 A2058G and 1 A2059G correctly identified 

3 Cervical swab: 2 A2058G correctly identified 

4 Vaginal swab: 3 A2058G, 2 A2058T and 1 A2059G correctly identified; ^ 1 vaginal swab was identified as a mixture 
WT/A2059G  

5 High vaginal swab: 1 A2059G correctly identified  

6 Male rectal swab: 5 A2059G, 1 A2058T and 1 A2058G correctly identified; 1 A2058G was incorrectly identified as M. 
genitalium not detected 

7 Male urethral swab: 2 A2059G correctly identified  

8 Penile meatal swab: 1 A2059G correctly identified 
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Table 30. M. genitalium 23S rRNA mutation analysis 
(Clinical Study 6) 

Reference result^ ResistancePlus® MG result 

Wild type 25/261 

A2058G 16/172 

A2059G 27/273  

A2058T 6/74 

A2058C - 

A2059C - 

^ For M. genitalium positive samples only 

1 Wild type: 1 vaginal swab miscalled as M. genitalium not detected 

2 A2058G: 1 rectal swab miscalled as M. genitalium not detected 

3 A2059G: 1 vaginal swab mixed wild-type/A2059G correctly identified as 
M. genitalium, 23S mutation detected 

4 A2058T: 1 male urine swab miscalled as M. genitalium not detected 

 

16.1.7 Clinical Study 7 

A retrospective clinical study was conducted at Microbiological Diagnostic Unit Public Health Unit (MDU), Victoria, Australia, using dry 
swabs and neat urine collected from October 2018-January 2019. Specimens consisted of 59 M. genitalium positive and 31 M. 
genitalium negative samples, including 15 anal swabs, 19 vaginal swabs, 2 high vaginal, 8 cervical, 1 urethral swab, as well as 45 
male urine specimens.  

The ResistancePlus® MG kit was performed on the LC480 II, after sample extraction on the QIAsymphony SP (QIAGEN) instrument 
using the DSP Virus/Pathogen Mini kit and the Complex200_V6_DSP protocol. Results were compared to the routine diagnostic 
results obtained from the ResistancePlus® MG kit (SpeeDx) using samples extracted on the MagNA Pure 96 Instrument (MP96). For 
discordant results, a 16S rRNA qPCR (Twin 2011) test was performed for M. genitalium detection, and Sanger sequencing (Twin 
2012) was performed for 23S rRNA mutant detection. The sensitivity and specificity of the ResistancePlus® MG kit for M. genitalium 
detection and 23S rRNA mutant detection are shown in Table 31. Analysis of 23S rRNA mutation detection only includes samples 
where the mutant status could be determined. Analysis of results in accordance to specimen type is shown in Table 32.  

 

Table 31. Clinical evaluation of the ResistancePlus® MG kit (Clinical Study 7) 

 M. genitalium detection 

ResistancePlus® MG (MP96) 

  23S rRNA mutant detection 

ResistancePlus® MG (MP96) 

 Positive Negative   Mutant Wild type 

ResistancePlus® 
MG 
(QIAsymphony SP) 

Positive 54 0%  Mutant detected 28  1# 

Negative 1* 34  Mutant not detected 1# 22 

 

Sensitivity 98.2% (95% CI 90.3-100.0%)  Sensitivity 96.6% (95% CI 82.2-99.9%) 

Specificity 100.0% (95% CI 89.7-100.0%)  Specificity 95.7% (95% CI 78.1-99.9%) 

* The ResistancePlus® MG kit detected 6 true M. genitalium negative samples which were positive with reference test, table represents resolved 
results 

% The ResistancePlus® MG kit detected 2 true M. genitalium positive samples which were negative with reference test, table represents resolved 
results 

# 2 discordant urine samples could not be resolved as sequencing failed  

  



Instructions for Use (IFU)    

IF-IV0003 v13.0 (July 2023)  Page 32 of 77 

EN 

Table 32. Clinical result analysis in accordance to specimen (Clinical Study 7) # 

Specimen Expected M. genitalium 
negative 

Expected M. genitalium 
23S rRNA wild type 

Expected M. genitalium 
23S rRNA mutant 

Male Urine 17/17 9/9 12/141 

Female Urine 1/1 1/22 1/1 

Cervical swab  3/3 2/2 3/3 

Vaginal swab 8/8# 7/7 3/3 

High vaginal swab 1/1 1/1 - 

Male Anal swab 4/4 2/2 8/8 

Male urethral swab - - 1/1 

# 1 vaginal swab was excluded as it produced an invalid result with the ResistancePlus® MG kit 

1 Male urine: 1 M. genitalium 23S rRNA wild type was incorrectly identified as M. genitalium not detected; 1 M. genitalium 23S rRNA mutant 
was incorrectly identified as M. genitalium detected, 23S mutation not detected 

2 Female urine: 1 incorrectly identified as M. genitalium detected, 23S rRNA mutation detected 

 

16.2 Analytical performance 

16.2.1 Reproducibility and repeatability 

The reproducibility and repeatability of the ResistancePlus® MG kit on the LC480 II was assessed using quantified synthetic template 
for M. genitalium MgPa and 23S rRNA targets (A2058G, A2059G, A2058T, A2058C and A2059C) at 10,000 and 3x LOD copies per 
reaction using 6 replicates (unless otherwise specified). Experiments were performed on the LC480 II. 

To determine lot-to-lot variability, two lots were tested, run on one machine performed by one operator (Table 33). The two lots showed 
good reproducibility with coefficient of variation (%CV) between 0.35-2.37% for all targets. 

 

Table 33. Lot-to-lot variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 16.9 0.15 0.89 12/12 

MgPa 30 copies 25.5 0.52 2.05 12/12 

A2058G 10,000 copies 20.4 0.48 2.37 12/12 

A2058G 36 copies 27.8 0.43 1.54 12/12 

A2059G 10,000 copies 18.0 0.06 0.35 12/12 

A2059G 30 copies 25.6 0.50 1.94 12/12 

A2058T 10,000 copies 18.7 0.09 0.46 12/12 

A2058T 30 copies 26.2 0.30 1.14 12/12 

A2058C 10,000 copies 17.7 0.13 0.75 12/12 

A2058C 30 copies 25.4 0.29 1.15 12/12 

A2059C 10,000 copies 19.2 0.08 0.42 12/12 

A2059C 45 copies 25.0 0.26 1.03 12/12 

 

To determine day-to-day variability, testing was performed over three days by one operator on the same machine (Table 34). The 
three runs showed good reproducibility between different days with coefficient of variation between 0.44-2.31% for all targets. 
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Table 34. Day-to-day variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 17.0 0.18 1.09 18/18 

MgPa 30 copies 25.6 0.59 2.31 18/18 

A2058G 10,000 copies 20.2 0.37 1.83 18/18 

A2058G 36 copies 27.9 0.51 1.84 18/18 

A2059G 10,000 copies 18.1 0.24 1.34 18/18 

A2059G 30 copies 25.7 0.32 1.23 18/18 

A2058T 10,000 copies 18.7 0.23 1.22 18/18 

A2058T 30 copies 26.3 0.31 1.17 18/18 

A2058C 10,000 copies 17.8 0.16 0.88 18/18 

A2058C 30 copies 25.5 0.31 1.22 18/18 

A2059C 10,000 copies 19.2 0.08 0.44 18/18 

A2059C 45 copies 25.0 0.46 1.82 18/18 

 

To determine run-to-run variability, three qPCR runs were compared, run on the same day by the same operator (Table 35). The three 
runs showed good reproducibility with coefficient of variation between 0.40-3.20% for all targets. 

 

Table 35. Run-to-run variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 17.0 0.07 0.40 18/18 

MgPa 30 copies 25.7 0.47 1.83 18/18 

A2058G 10,000 copies 19.8 0.63 3.20 18/18 

A2058G 36 copies 27.5 0.51 1.85 18/18 

A2059G 10,000 copies 18.4 0.11 0.61 18/18 

A2059G 30 copies 25.7 0.39 1.52 18/18 

A2058T 10,000 copies 18.7 0.22 1.18 18/18 

A2058T 30 copies 26.4 0.42 1.59 18/18 

A2058C 10,000 copies 17.8 0.08 0.46 18/18 

A2058C 30 copies 25.5 0.31 1.22 18/18 

A2059C 10,000 copies 19.2 0.15 0.76 18/18 

A2059C 45 copies 25.2 0.40 1.57 18/18 

 

To determine operator variability, two runs were compared from two operators (Table 36). The two runs from different operators 
showed good reproducibility with coefficient of variation between 0.54-1.86% for all targets. 
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Table 36. Operator variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 16.8 0.12 0.73 12/12 

MgPa 30 copies 25.3 0.41 1.61 12/12 

A2058G 10,000 copies 20.2 0.24 1.21 12/12 

A2058G 36 copies 27.9 0.45 1.62 12/12 

A2059G 10,000 copies 17.9 0.10 0.58 12/12 

A2059G 30 copies 25.5 0.39 1.53 12/12 

A2058T 10,000 copies 18.6 0.10 0.54 12/12 

A2058T 30 copies 26.1 0.31 1.20 12/12 

A2058C 10,000 copies 17.7 0.13 0.71 12/12 

A2058C 30 copies 25.2 0.27 1.06 12/12 

A2059C 10,000 copies 19.1 0.16 0.83 12/12 

A2059C 45 copies 24.9 0.46 1.86 12/12 

 

To determine instrument variability, two runs from two machines were compared, performed by the same operator (Table 37). The 
runs from different instruments showed good reproducibility with coefficient of variation between 0.21-2.62% for all targets. 

 

Table 37. Instrument variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 16.7 0.10 0.60 12/12 

MgPa 30 copies 25.4 0.67 2.62 12/12 

A2058G 10,000 copies 20.0 0.07 0.33 12/12 

A2058G 36 copies 27.8 0.51 1.82 12/12 

A2059G 10,000 copies 17.8 0.05 0.30 12/12 

A2059G 30 copies 25.3 0.36 1.41 12/12 

A2058T 10,000 copies 18.5 0.09 0.50 12/12 

A2058T 30 copies 25.9 0.30 1.16 12/12 

A2058C 10,000 copies 17.6 0.13 0.75 12/12 

A2058C 30 copies 25.3 0.36 1.44 12/12 

A2059C 10,000 copies 18.9 0.04 0.21 12/12 

A2059C 45 copies 24.8 0.46 1.85 12/12 

 

To determine within-run variability, three experiments were compared, set up separately by the same operator running each target on 
the same plate (Table 38). The three experiments showed good reproducibility with coefficient of variation between 0.57-3.12% for all 
targets. 
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Table 38. Within-run variability 

 Average Cq STDEV %CV # samples 

MgPa 10,000 copies 17.3 0.36 2.09 18/18 

MgPa 30 copies 25.9 0.81 3.12 18/18 

A2058G 10,000 copies 20.2 0.11 0.57 18/18 

A2058G 36 copies 28.0 0.65 2.31 18/18 

A2059G 10,000 copies 17.9 0.15 0.83 18/18 

A2059G 30 copies 25.8 0.38 1.46 18/18 

A2058T 10,000 copies 18.8 0.12 0.66 18/18 

A2058T 30 copies 26.8 0.38 1.41 18/18 

A2058C 10,000 copies 17.8 0.15 0.83 18/18 

A2058C 30 copies 25.5 0.36 1.41 18/18 

A2059C 10,000 copies 19.0 0.14 0.76 18/18 

A2059C 45 copies 25.0 0.42 1.66 18/18 

 

16.2.2 Analytical sensitivity 

The analytical sensitivity of the ResistancePlus® MG kit on the LC480 II was determined by running limited dilution series’, using 
quantified synthetic template for M. genitalium MgPa and 23S rRNA targets (A2058G, A2059G, A2058T, A2058C and A2059C). The 
sensitivity for each target was determined as the number of copies per reaction with ≥ 95% detection shown in Table 39. 

 

Table 39. Analytical sensitivity 

 Analytical Sensitivity 
(copies/reaction) 

MgPa 10 

A2058G 12 

A2059G 10 

A2058T 10 

A2058C 10 

A2059C 15 

 

16.2.3 Analytical specificity 

This study was conducted to evaluate the ResistancePlus® MG kit when non-target organisms are present at high concentrations. A 
panel of 65 microorganisms (4 viruses, 2 protozoans, 4 fungi and 55 bacteria) representing pathogens or flora commonly present in 
the urogenital system, or closely related to M. genitalium, were evaluated. Each bacterial strain was tested at 1 x 106 genomes/ml, 
unless otherwise stated. Viral strains were tested at 1 x 105 genomes/ml, unless otherwise stated. All other organisms were tested at 
the concentrations stated. All organisms were quantified using qPCR, except those quantified as Colony Forming Units (CFU) or 
Plaque Forming Units (PFU) (Table 40). All microorganisms were tested in triplicate. All microorganisms tested were diluted into 
negative clinical matrix (either urine or vaginal swab). 

Results indicated that none of these organisms produced false positive results in the M. genitalium negative matrices (Table 40). 

An in silico analysis was also performed to evaluate if the oligonucleotides in the ResistancePlus® MG assay could amplify and detect 
nucleic acid sequences from non-target organisms available in BLAST. No significant interactions were detected. 
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Table 40. Microorganisms tested for analytical specificity 

Organism 
Concentration 
(genomes/ml) 

Organism 
Concentration 
(genomes/ml) 

Organism 
Concentration 
(genomes/ml) 

Actinomyces israelii 1 x 106 HIV-1^ 1 x 103 Mycoplasma pirum (2)* 1 x 106 

Atopobium vaginae 1 x 106 HPV type 18 (HeLa cells)^ 1 x 105 Mycoplasma pneumoniae (6)* 1 x 106 

Bacterioides fragilis 1 x 106 Klebsiella oxytoca 1 x 106 Mycoplasma primatum 1 x 106 

Bifidobacterium adolescentis 1 x 106 Lactobacillus acidophilus 1 x 106 Mycoplasma salivarium 1 x 106 

Campylobacter jejuni 1 x 106 Lactobacillus crispatus 1 x 106 Neisseria gonorrhoeae 1 x 106 

Candida albicans 1 x 105 Lactobacillus jensenii 1 x 106 Pentatrichomonas hominis# 1 x 105 

Candida glabrata 1 x 106 Lactobacillus vaginalis 1 x 106 Peptostreptococcus anaerobius 1 x 106 

Candida parapsilosis 1 x 106 Listeria monocytogenes 1 x 106 Prevotella bivia 1 x 106 

Candida tropicalis 1 x 105 Mobiluncus curtisii 1 x 106 Propionibacterium acnes 1 x 105 

Chlamydia trachomatis 1 x 106 Mycobacterium smegmatis 1 x 105 Proteus mirabilis 1 x 106 

Clostridium perfringens 1 x 106 Mycoplasma alvi 1 x 106 Proteus vulgaris 1 x 106 

Corynebacterium genitalium 1 x 106 Mycoplasma amphoriforme (2)* 1 x 106 Pseudomonas aeruginosa 1 x 106 

Enterobacter aerogenes 1 x 106 Mycoplasma arginini 1 x 106 Staphylococcus aureus 1 x 106 

Enterobacter cloaceae 1 x 106 Mycoplasma buccale 1 x 106 Staphylococcus saprophyticus 1 x 106 

Enterococcus fecalis 1 x 106 Mycoplasma fermentans 1 x 106 Streptococcus agalactiae 1 x 106 

Fusobacterium nucleatum 1 x 106 Mycoplasma gallisepticum 1 x 104 Streptococcus pyogenes 1 x 106 

Gardnerella vaginalis 1 x 106 Mycoplasma hominis 1 x 106 Trichomonas vaginalis#  1 x 105 

Haemophilus ducreyi 1 x 106 Mycoplasma lipohilum 1 x 104 Ureaplasma urealyticum 1 x 105 

Herpes simplex virus I 1 x 106 Mycoplasma orale 1 x 106 
  

Herpes simplex virus II 1 x 106 Mycoplasma penetrans 1 x 106 
  

* number in brackets denotes the number of strains tested 

^ quantified as PFU/ml 

# quantified as CFU/ml 

 

16.2.4 Potentially interfering substances 

An interfering substances study was carried out to examine if substances or conditions that may be present in urine or vaginal swab 
specimens could affect the performance of the ResistancePlus® MG assay. The panel consisted of endogenous substances such as 
blood, mucin, leukocyctes, and medications (prescription and over-the-counter) that could be used to treat urogenital conditions. All 
substances were evaluated through the performance of the Internal Control, which monitors extraction and qPCR inhibition. All test 
samples were tested in triplicate. Substances were diluted in negative clinical matrix (either urine or vaginal swab) as appropriate. 

Results indicated that none of the substances and conditions interfered with detection of the Internal Control or produced false positive 
results. 

Results are summarised in Table 41 and Table 42. 
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Table 41. Potentially interfering substances in urine samples 

Class/Substance Product name Test concentration 

Whole blood  -- 1% v/v 

Semen  --  5.0% v/v 

Mucus Mucin 0.8% w/v 

Antibiotics 

Azithromycin 1.8 mg/ml 

Doxycycline 3.6 mg/ml 

Analgesics 

Aspirin 40 mg/ml 

Paracetamol 3.2 mg/ml 

Intravaginal hormones  --  
7 mg/ml Progesterone +  

0.07 mg/ml Beta Estradiol 

Leukocytes  --  105 cells/ml 

Albumin Bovine serum albumin 10 mg/ml 

Glucose  --  10 mg/ml 

Acidic urine (pH 4.0) Urine + N-Acetyl-L-Cysteine pH 4.0 

Alkaline urine (pH 9.0) Urine + Ammonium Citrate pH 9.0 

Bilirubin  --  1 mg/ml 
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Table 42. Potentially interfering substances in vaginal swab samples 

Class/Substance Product name Test concentration 

Blood  --  60% v/v 

Seminal fluid  --  5.0% v/v 

Mucus Mucin 0.8% w/v 

Over-the-counter vaginal products 
and contraceptives 

Vagisil Anti-Itch Crème (1.0 oz) 0.25% w/v 

K-Y Jelly (4.0 oz) 0.25% w/v 

Options Gynol II Vaginal 
Contraceptive Gel 

0.25% w/v 

Walgreens Clotrimazole Vaginal 
Cream (1.5 oz) 

0.25% w/v 

Vagisil Sensitive Skin Formula 
Maximum Strength Anti-Itch 
Creme with Oatmeal (1.0 oz) 

0.25% w/v 

Vagisil ProHydrate Natural Feel 
Internal Moisturizing Gel (0.2 oz x 

8 pack) 
0.25% w/v 

Vagisil Daily Intimate Deodorant 
Powder (8.0 oz) 

0.25% w/v 

Summer's Eve Medicated Douche 0.25% v/v 

Deodorant & powders 
Summer's Eve Deodorant spray 

(2.0 oz) 
0.25% v/v 

Hemorrhoidal cream 
Preparation H Hemorrhoidal 

Cream (0.9 oz) 
0.25% w/v 

Prescription-only medicines 

Metronidazole Vaginal Gel, 0.75% 0.25% w/v 

Estrace® (estradiol vaginal cream, 
USP 0.01%) 

0.25% w/v 

Leukocytes  --   105 cells/ml 

Intravaginal hormones  --  
7 mg/ml Progesterone +  

0.07 mg/ml Beta Estradiol 

 

17 Customer and technical support 

Please contact Technical Support for questions on reaction setup, cycling conditions and other enquiries.  

Tel: +61 2 9209 4169, Email: tech@speedx.com.au 

  

mailto:tech@speedx.com.au
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19 Appendix 1: LightCycler® 480 instrument II 

The following information is based on LightCycler® 480 Software (version 1.5). 

The ResistancePlus® MG kit contains dyes for the LightCycler® 480 Instrument II. The PlexPCR® Colour Compensation kit (Cat no 
90001) must be run and applied for LC480 II analysis (see Section 19.2). This kit can be supplied on request. 

 

19.1 Programming the LightCycler® 480 Instrument II (LC480 II) 

Detection Format 

Create a custom Detection Format 

Open Tools > Detection Formats 

Create a New Detection Format, and name ‘SpeeDx PlexPCR’ (may be created during the generation of SpeeDx Colour 
Compensation file) (See Figure 3). 

For Filter Combination Selection select the following (Excitation-Emission): 

 

 Table 43. Filter combinations^ 

LC480 II 440-488 465-510 533-580 533-610 533-640 618-660 

^ These Filter Combinations are the default names for the channels 

 

Set the Selected Filter Combination List for all channels as: 

Melt Factor: 1 

Quant Factor: 10 

Max Integration Time (sec): 1 

Figure 3. Custom SpeeDx Detection Format 

 

Instrument Settings 

Create a custom Detection Format 

Open Tools > Instruments 

For Instrument Settings > select Barcode Enabled 
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Experiment setup 

Select New Experiment 

In the Run Protocol tab 

For Detection Format select the custom ‘SpeeDx PlexPCR’ (Figure 4) 

Select Customize >  

Select Integration Time Mode > Dynamic 

 Select the following Active Filter Combinations shown in Table 44 

 

Table 44. Channels for ResistancePlus® MG targets 

M. genitalium detection 
(MgPa) 

23S rRNA mutation Internal Control 

465-510 533-580 533-640 

 

Figure 4. Customize Detection Format 

 

To enable automated sample detection in the analysis software, assign nametags to the wells on the plate 

Open the Sample Editor module 

Select well 

Edit Sample Name to match nametag defined in Assays module of the analysis software (see Section 24.4) 

Samples are labelled as Prefix_Suffix (as shown in Table 45 and Figure 5) e.g. Pa_MG  

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 

 

Table 45. Sample nametags for analysis software 

Sample type 
Prefix 

(in analysis software) 

_Suffix 

(in analysis software) 

Sample name 

(in LC480) 

Regular sample S _MG S_MG 

Negative control N _MG N_MG 

Positive control (MG, 23S rRNA mutant type) (Pa) Pa _MG Pa_MG 

Positive control (MG, 23S rRNA wild type) (Pb) Pb _MG Pb_MG 
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Figure 5. Sample Editor – Assigning nametags to wells 

 

Set Reaction Volume > 20 μl 

Create the following Program (shown in more detail in Figure 6 – Figure 9): 

 

Table 46. Thermocycling Program 

Program name Cycles Target C Hold Ramp rate (C/s)≠ 

Polymerase activation 1 95C 2 min 4.4 

Touch down cyclingᵟ:  

Step down -0.5C/cycle 
10 

95C 5 s 4.4 

61C – 56.5Cᵟ 30 s 2.2 

Quantification cycling+: 
Acquisition/Detection 

40 

95C 5 s 4.4 

52C+ 40 s 2.2 

Cooling 1 40C 30 s 2.2 

≠ Default ramp rate (96 well plate) 

ᵟ Step size: -0.5C/Cycle, Sec Target: 56C 

+ Analysis mode: Quantification, Acquisition mode: Single 

 

Figure 6. Thermocycling Program – Polymerase activation 
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Figure 7. Thermocycling Program – Touchdown cycling 

 

Figure 8. Thermocycling Program – Quantification cycling 
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Figure 9. Thermocycling Program – Cooling 

 

 

> Start Run 

 

When the cycling program has finished, export a .ixo file for analysis in the ResistancePlus® MG (LC480) analysis software. 

Select Export 

Save in an easily identifiable location 

 

19.2 Colour Compensation for LightCycler® 480 Instrument II 

NOTE: The PlexPCR® Colour Compensation (Cat no 90001) kit must be run and applied for LC480 II analysis. This kit can be supplied 
on request.  

 

For analysis using the software, the Sample Name of the colour compensation reactions must be labelled as shown in Table 47. 

When the cycling program has finished, export a .ixo file for analysis in the ResistancePlus® MG (LC480) analysis software. 

Select Export 

Save in an easily identifiable location and name as “SpeeDx PlexPCR” 
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19.3 Interpretation of results 

Data interpretation requires the ResistancePlus® MG (LC480) analysis software. The analysis software can be supplied on request. 
Please contact tech@speedx.com.au for more information. 

Refer to Section 24 for instructions for using the ResistancePlus® MG (LC480) analysis software. 

  

Table 47. Sample name for colour compensation reactions for the analysis software 

Reactions 

 BLANK 488 mix 510 mix 580 mix 610 mix 640 mix 660 mix 

Dominant Channel Water 440-488 465-510 533-580 533-610 533-640 618-660 

Sample Name BLANK 440-488 465-510 533-580 533-610 533-640 618-660 

mailto:tech@speedx.com.au
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20 Appendix 2: cobas z 480 analyser 

The following information is based on the cobas z 480 analyser Software (LightCycler 480 SW UDF 2.1.0). Contact your Roche 
representative for support in accessing the UDF software on your cobas z 480 analyser. 

The ResistancePlus® MG kit contains dyes for the cobas z 480 analyser. The PlexPCR® Colour Compensation kit (Cat no 90001) 
must be run and applied for z 480 analysis (see Section 20.2). This kit can be supplied on request. 

 

20.1 Programming the cobas z 480 analyser 

Detection Format 

Create a custom Detection Format 

Open Tools > Detection Formats 

Create a New Detection Format, and name ‘SpeeDx PlexPCR’ (may be created during the generation of SpeeDx Colour 
Compensation file) (See Figure 10). 

For Filter Combination Selection select the following (Excitation-Emission): 

 

 Table 48. Filter combinations^ 

z 480 465-510 540-580 540-610 540-645 610-670 

^ These Filter Combinations are the default names for the channels 

 

Set the Selected Filter Combination List for all channels as: 

Melt Factor: 1 

Quant Factor: 10 

Max Integration Time (sec): 1 

Figure 10. Custom SpeeDx Detection Format 
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Instrument Settings 

Create a custom Detection Format 

Open Tools > Instruments 

For Instrument Settings > select Barcode Enabled 

 

Experiment setup 

Select New Experiment 

In the Run Protocol tab 

For Detection Format select the custom ‘SpeeDx PlexPCR’ (Figure 11) 

Select Customize >  

Select Integration Time Mode > Dynamic 

 Select the following Active Filter Combinations shown in Table 49 

 

Table 49. Channels for ResistancePlus® MG targets 

M. genitalium detection 
(MgPa) 

23S rRNA mutation Internal Control 

465-510 540-580 540-645 

 

Figure 11. Customize Detection Format 

 

 

To enable automated sample detection in the analysis software, assign nametags to the wells on the plate 

Open the Sample Editor module 

Select well 

Edit Sample Name to match nametag defined in Assays module of the analysis software (see Section 24.4) 

Samples are labelled as Prefix_Suffix (as shown in Table 50 and Figure 12)  e.g. Pa_MG  

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 
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Table 50. Sample nametags for analysis software 

Sample type 
Prefix 

(in analysis software) 

_Suffix 

(in analysis software) 

Sample name 

(in z 480) 

Regular sample S _MG S_MG 

Negative control N _MG N_MG 

Positive control (MG, 23S rRNA mutant type) (Pa) Pa _MG Pa_MG 

Positive control (MG, 23S rRNA wild type) (Pb) Pb _MG Pb_MG 

 

Figure 12. Sample Editor – Assigning nametags to wells 

 

 

Set Reaction Volume > 20 μl 

Create the following Program (shown in more detail in Figure 13 - Figure 16): 

 

Table 51. Thermocycling Program 

Program name Cycles Target C Hold Ramp rate (C/s)≠ 

Polymerase activation 1 95C 2 min 4.4 

Touch down cyclingᵟ:  

Step down -0.5C/cycle 
10 

95C 5 s 4.4 

61C – 56.5Cᵟ 30 s 2.2 

Quantification cycling+: 
Acquisition/Detection 

40 

95C 5 s 4.4 

52C+ 40 s 2.2 

Cooling 1 40C 30 s 2.2 

≠ Default ramp rate (96 well plate) 

ᵟ Step size: -0.5C/Cycle, Sec Target: 56C 

+ Analysis mode: Quantification, Acquisition mode: Single 
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Figure 13. Thermocycling Program – Polymerase activation 

 

Figure 14. Thermocycling Program – Touchdown cycling 

 

 

Figure 15. Thermocycling Program – Quantification cycling 

 

 

 

 



Instructions for Use (IFU)    

IF-IV0003 v13.0 (July 2023)  Page 50 of 77 

EN 

Figure 16. Thermocycling Program – Cooling 

  

 

> Start Run 

 

When the cycling program has finished, export a .ixo file for analysis in the ResistancePlus® MG (z480) analysis software. 

Select Export 

Save in an easily identifiable location 

 

20.2 Colour Compensation for cobas z 480 analyser 

NOTE: The PlexPCR® Colour Compensation (Cat no 90001) kit must be run and applied for z480 analysis. This kit can be supplied 
on request.  

 

For analysis using the software, the Sample Name of the colour compensation reactions must be labelled as shown in Table 52. 

When the cycling program has finished, export a .ixo file for analysis in the ResistancePlus® MG (z480) analysis software. 

Select Export 

Save in an easily identifiable location and name as “SpeeDx PlexPCR” 
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20.3 Interpretation of results 

Data interpretation requires the ResistancePlus® MG (z480) analysis software. The analysis software can be supplied on request. 
Please contact tech@speedx.com.au for more information. 

Refer to Section 24 for instructions for using the ResistancePlus® MG (z480) analysis software. 

  

Table 52. Sample name for colour compensation reactions for the analysis software 

Reactions 

 BLANK 510 mix 580 mix 610 mix 640 mix 660 mix 

Dominant Channel Water 465-510 540-580 540-610 540-645 610-670 

Sample Name BLANK 465-510 540-580 540-610 540-645 610-670 

mailto:tech@speedx.com.au
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21 Appendix 3: Applied Biosystems® 7500 Fast 

The following information is based on 7500 Software v2.3. 

The ResistancePlus® MG(550) kit contains dyes for the Applied Biosystems® (ABI) 7500 Fast. Default dye calibrations are used for all 
channels. Custom calibration is not required. 

 

21.1 Programming the Applied Biosystems® 7500 Fast  

Select Advanced Setup 

In Setup > open Experiment Properties and select the following 

Name the experiment 

Instrument > 7500 Fast (96 Wells) 

Type of experiment > Quantitation – Standard Curve 

Reagents > Other 

Ramp Speed > Standard 

 

In Setup > open Plate Setup 

In Define Targets and Samples tab > 

Define Targets as shown below (define colours as required) 

 

Table 53. Define Targets 

Target name Reporter Quencher 

MgPa FAM None 

23S rRNA mutation JOE None 

IC TAMRA None 

 

To enable automated sample detection in the analysis software assign nametags to the wells on the plate  

In Setup > open Plate Setup 

In Define Targets and Samples tab > 

Define Samples  

Edit Sample Name to match nametags defined in Assays module of the analysis software (see Section 24.4) 

Samples are labelled as Prefix_Suffix (as shown in Table 54 and Figure 17) e.g. Pa_MG 

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 

 

Table 54. Sample nametags for analysis software 

Sample type 
Prefix 

(in analysis software) 

_Suffix 

(in analysis software) 

Sample name  

(in 7500 Fast) 

Regular sample S _MG S_MG 

Negative control N _MG N_MG 

Positive control (MG, 23S rRNA mutant type) (Pa) Pa _MG Pa_MG 

Positive control (MG, 23S rRNA wild type) (Pb) Pb _MG Pb_MG 
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Figure 17. Sample Editor – Assigning nametags to wells 

 

In Assign Targets and Samples tab > 

Select wells and assign targets and samples to the selected wells 

Select Passive reference > None 

 

In Setup > open Run Method 

Set Reaction Volume Per Well > 20 μl 

 

Create the following program (shown in more detail in Graphical View (Figure 18 and Figure 19) and Tabular View (Figure 20): 

 

Table 55. Thermocycling Program 

Program name Cycles Target C Hold Ramp≠ 

Polymerase activation 1 95C 2 min 100% 

Touch down cycling:  

Step down -0.5C/cycleᵟ 
10 

95C 5 s 100% 

61C – 56.5Cᵟ 30 s 100% 

Quantification cycling+:  

Acquisition/Detection 
40 

95C 5 s 100% 

52C+ 40 s 100% 

≠ Default ramp rate 

ᵟ Enable AutoDelta: -0.5C/cycle 

+ Collect data on hold 

 

Figure 18. Run method – Graphical view 
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Figure 19. Run method – Graphical view – Enable AutoDelta 

 

Figure 20. Run method – Tabular view 

 

In Setup > open Run Method 

Select Start Run 

 

21.2 Interpretation of results 

Data interpretation requires the ResistancePlus ® MG (7500) analysis software. The analysis software can be supplied on request. 
Please contact tech@speedx.com.au for more information. 

Refer to Section 24 for instructions for using the ResistancePlus® MG (7500) analysis software.  
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22 Appendix 4: Applied Biosystems 7500 Fast Dx  

The following information is based on SDS Software v1.4.1 for the 7500 Fast Dx. 

The ResistancePlus® MG(550) kit contains dyes for the Applied Biosystems® (ABI) 7500 Fast Dx. Default dye calibrations are used for 
all channels. Custom calibration is not required. 

 

22.1 Programming the Applied Biosystems® 7500 Fast Dx 

Select Create New Document 

In New Document Wizard select the following (Figure 21): 

Assay > Standard Curve (Absolute Quantification)  

Container > 96-Well Clear 

Template > Blank document 

Run mode > Standard 7500 

Operator > Enter Operator’s name 

Comments > Enter any comments or additional notes for the run file 

Plate Name > Assign a unique name to the run file 

Select Next 

Figure 21. New Document Wizard window 

 

In Select Detectors > select New Detector 

Define detectors as shown below (define colours as required) (Table 56 and Figure 22) 

 

Table 56. Define detectors 

Detectors Detector name Reporter dye Quencher 

Detector 1 MgPa FAM None 

Detector 2 23S rRNA mutation JOE None 

Detector 3 IC TAMRA None 

 

Select OK 
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Figure 22. New Detector window 

 

Select Detectors (Figure 23) 

Select detectors and Add to Document 

Select Passive reference > None 

 

Figure 23. Select Detectors window 

 

In Set Up sample plate > 

Select wells and assign 3 detectors to the selected wells 

- MgPa 

- 23S rRNA mutation 

- IC 

Select Next 

 

To enable automated sample detection in the analysis software, assign nametags to the wells on the plate 

In Setup > Plate tab 



Instructions for Use (IFU)    

IF-IV0003 v13.0 (July 2023)  Page 57 of 77 

EN 

Right click on well and select Well Inspector > Enter Sample Name 

 

Edit Sample Name to match nametag defined in Assays module of the analysis software (see Section 24.4) 

Samples are labelled as Prefix_Suffix (as shown in Table 57 and Figure 24) e.g. Pb_MG 

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 

 

Table 57. Sample nametags for analysis software 

Sample type 
Prefix_  

(in analysis software) 

_Suffix  

(in analysis software) 

Sample name 

(in 7500 Fast Dx) 

Regular sample S _MG S_MG 

Negative control N _MG N_MG 

Positive control (MG, 23S rRNA mutant type) (Pa) Pa _MG Pa_MG 

Positive control (MG, 23S rRNA wild type) (Pb) Pb _MG Pb_MG 

 

Figure 24. Setup plate view – Assigning nametags to wells 

 

Select Next 

 

In Instrument tab 

In Settings box 

For Sample Volume (μl): Enter 20 μl 

 

Create the following thermal cycler protocol (Table 58 and Figure 25 and Figure 26)   
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Table 58. Thermal Cycler Protocol 

Program name Cycles Target C Hold Ramp≠ 

Polymerase activation 1 95C 2 min 100% 

Touch down cycling:  

Step down -0.5C/cycleᵟ 
10 

95C 5 s 100% 

61C – 56.5Cᵟ 30 s 100% 

Quantification cycling+: Acquisition/Detection 40 

95C 5 s 100% 

52C+ 40 s 100% 

≠ Default ramp rate 

ᵟ Enable AutoDelta: -0.5C/cycle 

+ Collect data on hold 

 

Figure 25. Thermal Cycler Protocol – Thermal profile 

 

Figure 26. Thermal Cycler Protocol – Auto increment 
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22.2 Interpretation of results 

Data interpretation requires the ResistancePlus ® MG (7500) analysis software. The analysis software can be supplied on request. 
Please contact tech@speedx.com.au for more information. 

Refer to Section 24 for instructions for using the ResistancePlus® MG (7500) analysis software.  
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23 Appendix 5: Bio-Rad CFX96™ Dx and CFX96 Touch™ Real-Time PCR System 

The following information is based on Bio-Rad CFX Manager v3.1 

The ResistancePlus® MG(675) kit contains dyes for the CFX96 Real-Time PCR System. Default dye calibrations are used for all 
channels. Custom calibration is not required. 

 

23.1 Programming the CFX96™ Dx and CFX96 Touch™ Real-time PCR System 

Select View > Open Run Setup 

In Run Setup > Protocol tab > Select Create New 

In the Protocol Editor (see Figure 27):  

Set Sample Volume > 20 μl 

Create the following thermocycling program and save as ‘SpeeDx PCR’. This protocol can be selected for future runs. 

For Touch down cycling, select Step 3 and select Step options > Increment: -0.5°C/cycle (shown in more detail in 
Figure 28). 

 

Table 59. Thermocycling Program 

Program name Cycles Target C Hold 

Polymerase activation 1 95C 2 min 

Touch down cyclingᵟ:  

Step down -0.5C/cycle 
10 

95C 5 s 

61C – 56.5Cᵟ 30 s 

Quantification cycling+: 

Acquisition/Detection 
40 

95C 5 s 

52C+ 40 s 

ᵟ Step options > Increment: -0.5C/cycle 

+ Add Plate Read to Step 

 

Figure 27. Thermocycling Protocol – Graphical view 
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Figure 28. Step options 

 

In Run Setup > Plate tab  

Select Create New  

Select Settings > Plate Type > Select BR Clear 

Set Scan mode > All channels 

Select Fluorophores > FAM, HEX, Quasar 705 (see Table 60) 

Select wells containing samples and assign Sample Type and check Load for fluorophores (FAM, HEX, Quasar 705) 

Save plate 

 

Table 60. Channels for ResistancePlus® MG(675) targets 

M. genitalium detection 
(MgPa) 

23S rRNA mutation Internal control 

FAM HEX Quasar 705 

 

In Run Setup > Start Run tab 

Select Block 

Start Run 

 

To enable automated sample detection in the analysis software, assign nametags to the wells on the plate 

Open the Plate Setup module 

Select well 

Edit Sample Name to match nametag defined in Assays module of the analysis software (see Section 24.4) 

Samples are labelled as Prefix_Suffix (as shown in Table 61 and Figure 29) e.g. Pb_MG 

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 
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Table 61. Sample nametags for analysis software 

Sample type 
Prefix_ 

(in analysis software) 

Suffix 

(in analysis software) 

Sample name 

(in CFX96) 

Regular sample S _MG S_MG 

Negative control N _MG N_MG 

Positive control (MG, 23S rRNA mutant type) (Pa) Pa _MG Pa_MG 

Positive control (MG, 23S rRNA wild type) (Pb) Pb _MG Pb_MG 

 

Figure 29. Sample editor – Assigning nametags to wells 

 

 

23.2 Interpretation of results 

Data interpretation requires the ResistancePlus® MG (CFX) analysis software. The analysis software can be supplied on request. 
Please contact tech@speedx.com.au for more information. 

Refer to Section 24 for instructions for using the ResistancePlus® MG (CFX) analysis software. 
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24 Appendix A: Result interpretation 

Data interpretation requires the ResistancePlus® MG analysis software. While PlexPrime® primers offer greater specificity than other 
allele-specific primers, some non-specific amplification from the 23S rRNA mutant assay may be seen in samples that contain high 
concentrations of M. genitalium wild type 23S rRNA. The ResistancePlus® MG analysis software automates the data interpretation of 
amplification results and streamlines workflow. 

See Table 62 for the appropriate analysis software for each real-time PCR instrument. The analysis software can be supplied on 
request. Please contact tech@speedx.com.au for more information. 

 

Table 62. ResistancePlus® MG analysis software 

Cat no Analysis software* Real-time PCR instrument 

99003 ResistancePlus® MG (LC480) LC480 II 

99018 ResistancePlus® MG (z480) z 480 

99002 ResistancePlus® MG (7500) 7500 Fast and 7500 Fast Dx 

99008 ResistancePlus® MG (CFX) CFX96 Dx and CFX96 Touch 

99023 REFLEX ResistancePlus® MG (LC480)  LC480 II 

99024 REFLEX ResistancePlus® MG (z480) z 480 

99026 REFLEX ResistancePlus® MG (7500) 7500 Fast and 7500 Fast Dx 

99025  REFLEX ResistancePlus® MG (CFX) CFX96 Dx and CFX96 Touch 

* Refer to the website https://plexpcr.com/products/sexually-transmitted-infections/resistanceplus-mg/#resources to 
ensure you are using the most current version of analysis software. 

 

NOTE: Follow standard laboratory practices for transfer, reporting and storage of results to prevent loss of sample information. 

 

24.1 FastFinder platform – Minimum IT requirements 

The analysis software is available within the FastFinder platform (https://www.ugentec.com/fastfinder/analysis). The minimum IT 
requirements for installation of the FastFinder platform are listed below.  

 

Hardware requirements 

PC (Mac computers are not supported) 

Processor: 2 GHz, 2 GB RAM 

Disk space: 10Gb 

Internet Connection Cable or DSL, proxy not supported 

Min. screen resolution: 1366x768 pixels 

 

Supported client operating system 

Operating system Supported editions 

Windows 10 32-bit and 64-bit 

Windows 8.1 32-bit, 64-bit, and ARM 

Windows 8 32-bit, 64-bit, and ARM 

Windows 7 SP1 32-bit and 64-bit 

Windows Vista SP2 32-bit and 64-bit 
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Supported browsers 

FastFinder Administrator account users require one of the following: 

• Internet Explorer 11 or newer 

• Microsoft Edge 25 or newer 

• Firefox 45 or newer 

• Google Chrome 47 or newer. 

It may run on older versions, but these are not officially supported. 

 

Software requirements 

To use the FastFinder software, at least .NET 4.6.1 is necessary. For more information about the .NET framework, please visit the 
Microsoft Windows help pages. 

  

Antivirus settings 

Your antivirus software might put the FastFinder installer (UgenTec.FastFinder.Installer.exe) in quarantine. Please add this file to the 
antivirus whitelist. Example: Symantec (Risk: WS.Reputation.1) 

  

Firewall requirements 

https Connections should be allowed to *.fastfinderplatform.com:443 

 

For further detailed instructions on the FastFinder platform, refer to the FastFinder Instructions For Use accessible from the Help 
menu. 

To access the Help menu 

- Open the start menu  

- Select   or Help section and then select Product Documentation followed by Instructions For Use  

 

    

 

24.2 Device set up (new user or device) 

Refer to the FastFinder Instructions For Use for detailed instructions to set up device, accessible from the Help menu  

Open FastFinder 

- Select Devices from the workflow bar 

> Select Add  

> Select a file (run file) for the new device 

- To change the Current directory 

> Select Browse and select the folder containing relevant files 

> Select Next 

- Add device information 

> Select Save 
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24.2.1 Colour Compensation 

NOTE: See Section 19.2 and Section 20.2 for more information on Colour Compensation 

 

For LC480 II and z 480 devices, a colour compensation file must be added to the device 

- Select the LC480 II or z 480 device    

> In the Colour Compensation section, select   

> Select the colour compensation file for the device from the directory 

- To change the Current directory 

> Select Browse and select the folder containing relevant files 

- Select Next  

- Select ResistancePlus MG (LC480), ResistancePlus MG (z480), REFLEX ResistancePlus MG (LC480), or REFLEX 
ResistancePlus MG (z480) from the list to link to this assay 

- Select Save  

 

New or additional colour compensation files can be added to a device or deactivated as needed.   

In the device colour compensation section 

- Next to the file name, select   

 

- Select  to activate or deactivate a colour compensation file for an assay 

- Select Save  

 

24.3 Assay plug-in (new user) 

Refer to the FastFinder Instructions For Use for detailed instructions to set up assays, accessible from the Help menu  

 

Open FastFinder 

- Select Assays from the workflow bar 

- Select Add  

> For LC480 II > Select ResistancePlus MG (LC480) from the list 

> For z 480 > Select ResistancePlus MG (z480) from the list 

> For 7500 Fast and 7500 Fast Dx > Select ResistancePlus MG (7500) from the list 

> For CFX96 Dx and CFX96 Touch > Select ResistancePlus MG (CFX) from the list 

> For analysis of samples extracted without IC on the LC480 (reflex workflow) > Select REFLEX ResistancePlus® MG 
(LC480) from the list 

> For analysis of samples extracted without IC on the z 480 (reflex workflow) > Select REFLEX ResistancePlus® MG (z480) 
from the list 

> For analysis of samples extracted without IC on the 7500 Fast and 7500 Fast Dx (reflex workflow) > Select REFLEX 
ResistancePlus® MG (7500) from the list 

> For analysis of samples extracted without IC on the CFX96 Dx and CFX96 Touch (reflex workflow) > Select REFLEX 
ResistancePlus® MG (CFX) from the list 

- Select Add 

 

To activate or de-activate versions of the assay plug-in 

- In General assay information 

> Select  Versions 
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> Select  to activate or deactivate the version of the assay 

 

> Select Save 

 

24.4 Sample naming  

Sample nametags can be assigned to an assay plug-in to automate detection of wells and sample types for analysis.  

Select Assays from the workflow bar 

- In the Sample type nametags (prefix), select   

> Select   to add a nametag to define sample type nametags (Negative control, Positive control/s and Regular sample) 

> Add desired word, acronym, or letter to text box  

> Select Save 

- In Mix definition nametags (suffix), select   

> Select   to add a nametag to define the mix name 

> Add desired word, acronym, or letter to text box  

> Select Save 

- In the instrument software (before or after run is completed) assign the same nametag to appropriate wells 

> For LC480 II see Section 19 for instructions on programming sample nametags in the run file 

> For z 480 see Section 20 for instructions on programming sample nametags in the run file 

> For 7500 Fast see Section 21 for instructions on programming sample nametags in the run file 

> For 7500 Fast Dx see Section 22 for instructions on programming sample nametags in the run file 

> For CFX96 Dx and CFX96 Touch see Section 23 for instructions on programming sample nametags in the run file 

 

NOTE: Sample nametags are case sensitive. The nametag must match exactly to those assigned in the run file. 

 

24.5 Adding mix lot numbers 

Mix lot numbers can be assigned to the assay to enable traceability of reagents 

- Select Assays from the workflow bar 

> In the Assay Lot: Select    to add a new lot or select  to edit an existing lot 

> Once added, lot numbers will become available in the analysis module 

Select   to show all lot numbers or only active lot numbers 

 

24.6 Analysis 

Select Analyses from the workflow bar to start a new analysis 

 

 

Search for the file to be uploaded for analysis from a specified directory 

- To change the Current directory 

> Select Browse and select the folder containing relevant files 

- Select run (data) file from the list 

> Select Next step 
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Assign the assay information to the plate manually if sample naming has not been set up in Assays module 

- For LC480 II > Select ResistancePlus MG (LC480) 

- For z 480 > Select ResistancePlus MG (z480) 

- For 7500 Fast and 7500 Fast Dx > Select ResistancePlus MG (7500) 

- For CFX96 Dx and CFX96 Touch > Select ResistancePlus MG (CFX)   

- For analysis of samples extracted without IC on the LC480 > Select REFLEX ResistancePlus® MG (LC480)  

- For analysis of samples extracted without IC on the z 480 > Select REFLEX ResistancePlus® MG (z480)  

- For analysis of samples extracted without IC on the 7500 Fast and 7500 Fast Dx > Select REFLEX ResistancePlus® MG (7500)  

- For analysis of samples extracted without IC on the CFX96 Dx and CFX96 Touch > Select REFLEX ResistancePlus® MG (CFX)  

- Select wells and assign as: 

> Regular sample (S) 

> Negative control (N) 

> Positive control (MG, 23S rRNA mutant type) (Pa) 

> Positive control (MG, 23S rRNA wild type) (Pb) 

- Select Next step 

 

To save the plate layout as a template for future use 

- Select wells and assign types of samples 

> Select  to save template 

- Specify template name for future use 

> Select Save 

 

To load a previously saved plate template 

- Select  to load plate template 

> Select template from drop down menu 

> Check the box to load sample types specified within the plate template 

> Select Load 

 

 

- For LC480 II > Select ResistancePlus MG (LC480)  

> Select the appropriate colour compensation file from the drop down menu 

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For z 480 > Select ResistancePlus MG (z480)  

> Select the appropriate colour compensation file from the drop down menu 

> Select Assay Lot from the drop down menu 

> Select Analyse 
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- For 7500 Fast and 7500 Fast Dx > Select ResistancePlus MG (7500)   

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For CFX96 Dx and CFX96 Touch > Select ResistancePlus MG (CFX)   

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For samples extracted without IC (reflex workflow) on LC480 II > Select REFLEX ResistancePlus MG (LC480) 

> Select the appropriate colour compensation file from the drop down menu 

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For samples extracted without IC (reflex workflow) on z 480 > Select REFLEX ResistancePlus MG (z480) 

> Select the appropriate colour compensation file from the drop down menu 

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For samples extracted without IC (reflex workflow) on 7500 Fast and 7500 Fast Dx > Select REFLEX ResistancePlus MG (7500) 

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

- For samples extracted without IC (reflex workflow) on CFX96 Dx and CFX96 Touch > Select REFLEX ResistancePlus MG 
(CFX) 

> Select Assay Lot from the drop down menu 

> Select Analyse 

 

24.7 Results 

See Table 63 for a summary of possible reported sample results. 

 

NOTE: It is highly recommended that amplification curves should be confirmed for all positive samples. 

To resolve any uncertain results  

- Select Resolve tab 

- Select sample to resolve 

- Inspect amplification curves for uncertain results 

> Select  to plot a reference curve on the graph  

> Select  to plot a positive control on the graph 

> Select  to plot a negative control on the graph 

> Select    to confirm suggested result or select  to select a different option 

- Confirm as Negative or Inconclusive and add comments 

 

NOTE: For inconclusive samples, re-extract and re-test the samples once.  If sample result remains Inconclusive, collect a new sample 
to re-test. 
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To finalise analysis and prevent further user edits 

> Select Authorise Analysis 

> Select Yes to confirm 

- To reject analysis or restart the analysis 

> Select Restart Analysis or Reject Analysis 

> Select option to confirm 

 

24.8 Reference curve 

A reference curve can be saved and used to compare to samples on the same or across different plates 

- Select the sample of interest in either the Well Details or Target Details menu 

- From the amplification graph menu > Select       

> Select the check box for the channel of interest and add a label  

> Select Save to add signal as reference curve  

This reference curve will now appear linked to the assay in the Assays menu and can be inactivated at any time. 
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24.9 Overview of results 

 

Table 63. Results interpretation ResistancePlus® MG analysis software (Results Overview tab) 

 Well Name Assay Result Cq values^ Overall results 

 A1 Sample 1 ResistancePlus MG Negative CHANNEL C: 25.31 
Sample 1 - Negative 

M. genitalium not detected, IC valid 

 A2 Sample 2 ResistancePlus MG Positive 

CHANNEL A: 13.35 

CHANNEL B: 24.22 

CHANNEL C: 24.36 

Sample 2 - Positive 

M. genitalium detected, 

23S rRNA mutation not detected 

 A3 Sample 3 ResistancePlus MG Positive 
CHANNEL A:  23.32 

CHANNEL B:  31.64 

Sample 3 - Positive 

M. genitalium detected, 

23S rRNA mutation not detected 

 A4 Sample 4 ResistancePlus MG Positive 

CHANNEL A: 21.32 

CHANNEL B: 23.22 

CHANNEL C: 24.30 

Sample 4 - Positive 

M. genitalium, 23S rRNA mutation 
detected 

 A5 Sample 5 ResistancePlus MG Positive 
CHANNEL A: 23.16 

CHANNEL B: 24.31 

Sample 5 - Positive 

M. genitalium, 23S rRNA mutation 
detected 

 

A6 Sample 6 ResistancePlus MG Invalid CHANNEL C: 35.02 
Sample 6 - Invalid 

IC invalid, repeat test 1 
 

A7 
Sample 7 

(Flagged to resolve) 
ResistancePlus MG Positive 

CHANNEL A: 26.27 

CHANNEL B: 28.11 2 

CHANNEL C: 28.92 

Sample 7 - Positive 2 

M. genitalium, 23S rRNA mutation 
detected 

 

A7 
Sample 7 

(Resolve to Inconclusive) 
ResistancePlus MG Invalid 

CHANNEL A: 26.27 

CHANNEL C: 28.92 

Sample 7 - Invalid 3 

Inconclusive result, repeat test 1 

 

B2 
Pa  

(Mutant type Positive control) 
ResistancePlus MG Positive 

CHANNEL A: 25.01 

CHANNEL B: 24.23 

Pa - Positive 

Positive Control valid 

 

B3 
Pb  

(Wild type Positive control) 
ResistancePlus MG Positive CHANNEL A: 25.90 

Pb - Positive 

Positive Control valid 

 

B4 
N 

(Negative control) 
ResistancePlus MG Negative CHANNEL C: 26.25 

N - Negative 

Negative Control valid 

^ Refer to Table 12 for channel names for different instruments 

1 For IC invalid and inconclusive samples, re-extract and re-test 

2 A sample with an uncertain Cq will be flagged for resolution with  

3 A sample resolved to be Inconclusive is flagged with  

 

24.10 Exporting results 

- To export results 

> Select Exports in the workflow bar 

> Export one or more of the following report types: Cq values list (CSV), Results (CSV), Generic Amplification CSV or the 
appropriate LIS-integration file.  

> Select Exports 

- To download exports 

> Select Reports in the workflow bar 

> Select files and save 

- Alternatively export a customised report 

> Export Amplification Curve Analysis (PDF) 

> Select desired included information (graphs, audit trail, results overview) 
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> Select desired report settings to customise sample order 

- Select Exports 

> Open in Report Viewer to view, save and print 

 

24.11 Control Example Graphs 

The following examples show the amplification curves (baseline-corrected amplification curves) and the Results overview from the 
ResistancePlus MG (7500) analysis software for control sample types. 

 

24.11.1 M. genitalium, 23S rRNA mutant control (Pa) 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

B1 Pa ResistancePlus MG Positive 
CHANNEL A: 26.36 

CHANNEL B: 27.38 
 

Pa - Positive 

Positive Control valid 

 

24.11.2 M. genitalium, 23S rRNA wild type control (Pb) 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

D12 Pb ResistancePlus MG Positive 
CHANNEL A: 24.30 

CHANNEL B: 34.29 

Pb - Positive 

Positive Control valid 
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24.11.3 M. genitalium negative control (N) (negative specimen) 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

D12 N ResistancePlus MG Negative CHANNEL C: 27.65 
N - Negative 

Negative Control valid 

 

24.12 Examples 

The following examples show the amplification curves (baseline-corrected amplification curves) and the Results overview from the 
ResistancePlus MG (7500) analysis software for different samples. 

 

24.12.1 Example 1. High copy M. genitalium, 23S rRNA wild type sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

D2 Sample 12 ResistancePlus MG Positive 

CHANNEL A: 16.34 

CHANNEL B: 26.59 

CHANNEL C: 26.00 

Sample 12 - Positive 

M. genitalium detected, 

23S rRNA mutation not detected 

 

  



Instructions for Use (IFU)    

IF-IV0003 v13.0 (July 2023)  Page 73 of 77 

EN 

24.12.2 Example 2. Low copy M. genitalium, 23S rRNA wild type sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

F1 Sample 6 ResistancePlus MG  Positive 
CHANNEL A: 29.30 

CHANNEL C: 28.11  

Sample 6 - Positive 

M. genitalium detected, 

23S rRNA mutation not detected 

 

24.12.3 Example 3. High copy M. genitalium, 23S rRNA mutant sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

G3 Sample 9 ResistancePlus MG  Positive 

CHANNEL A: 18.08 

CHANNEL B: 22.31 

CHANNEL C: 28.03 

Sample 9 - Positive 

M. genitalium, 23S rRNA mutation detected 

 

24.12.4 Example 4. Low copy M. genitalium, 23S rRNA mutant sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

E3 Sample 21 ResistancePlus MG  Positive 

CHANNEL A: 29.08 

CHANNEL B: 29.23 

CHANNEL C: 26.13 

Sample 21 - Positive 

M. genitalium, 23S rRNA mutation detected 
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24.12.5 Example 5. Negative sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

E3 Sample 73 ResistancePlus MG  Negative CHANNEL C: 29.23 
Sample 73 - Negative 

M. genitalium not detected, IC valid 

 

24.12.6 Example 6. Invalid sample 

 

CHANNEL A   CHANNEL B   CHANNEL C 

Well Name Assay Result Cq values Overall results 

E3 Sample 35 ResistancePlus MG  Invalid CHANNEL C: 31.16 
Sample 35 - Invalid 

IC invalid, repeat test 

In this example, the IC signal is outside the channel cut-off. For IC invalid samples, re-extract the sample and then repeat test. 

 

24.12.7 Example 7. Samples to resolve – Negative signal  

In this example, CHANNEL B (JOE) was flagged for resolution with the software suggesting the sample is Negative (Figure 30). 

 

Figure 30. Samples to resolve as seen in the analysis software Resolve menu 

             

To determine appropriate action to take to resolve, another sample or control can be plotted for signal comparison 

- Select  to plot a positive reference curve (previously saved) for CHANNEL B (JOE)  

- Select  to plot a positive control from the run  

- Select  to plot a negative control from the run 
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CHANNEL B 

 

 

After inspection of the amplification curves (above) it can be seen that there is no amplification in the channel.  

The result is resolved by selecting the  icon, to confirm the Negative suggestion from the software. The resolved result is 
shown in Figure 31 below.  

 

Figure 31. Resolved result as seen in the analysis software Resolve menu 
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24.12.8 Example 8. Samples to resolve – Inconclusive signal 

In this example, CHANNEL B (JOE) was flagged for resolution with the software suggesting sample is Positive (Figure 32). 

 

Figure 32. Samples to resolve as seen in the analysis software Resolve menu 

               

 

 

 

 

 

To determine appropriate action to take to resolve, plot another sample or control for signal comparison 
 

- Select  to plot a positive reference curve (previously saved) for CHANNEL B (JOE)  
 

- Select  to plot a positive control from the run  
 

- Select  to plot a negative control from the run 

CHANNEL B 

 

After inspection of the amplification curves (above) there is potential amplification in the channel.  

 

It is recommended to resolve to Inconclusive, by selecting the                icon, and selecting the Inconclusive option from the 
drop-down menu. Comments can be added to the sample audit trail. The sample should be re-extracted and re-tested. The resolved 
result is shown in Figure 33 below. 

 

Refer to Table 63, Sample 7, for how results are displayed before and after resolution in the Results Overview tab. 

 

Figure 33. Resolved result as seen in the analysis software Resolve menu 
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25 Glossary 

 

 

          

European Conformity Catalogue number Batch code 

For In Vitro Diagnostic Use 

 

 

        

Authorised Representative Manufacturer Date of manufacture 

In the European Community 

 

 

        

Temperature limitation Contains sufficient for Use by Date 
           xxx determinations 

 

 

 

Importer              United Kingdom Conformity Assessment Mark 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SpeeDx products may be covered by one or more local or foreign patents. Please see www.plexpcr.com/patents for comprehensive 
patent information. 

PlexPCR®, ResistancePlus®, PlexPrime® and PlexZyme® are trademarks belonging to SpeeDx. Other copyright and trademarks are 
the property of the respective owner. 

© Copyright 2023 SpeeDx Pty. Ltd. 

xxx  

0123 

http://www.plexpcr.com/patents

